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ABSTRAK 

 

Yoel Chaeruman (1910107009) 

Analisis Faktor-Faktor yang Mempengaruhi Efektivitas Kerja Karyawan 

Pada PT. Taisei- Pulauintan Proyek Two Sen 

(xiv+80 halaman; 17 gambar; 20 tabel; 10 lampiran) 

Efektivitas kerja karyawan pada PT. Taisei-Pulauintan proyek Two Seno Apartemen sangat 

berpengaruh terhadap kinerja yang dilaksanakan dalam lapangan. Oleh karena itu, pengawasan 

terhadap faktor-faktor yang dapat mempengaruhi kinerja efektivitas kerja karyawan harus 

diperhatikan agar menjaga efektifitas kerja karyawan tidak menurun dan menjaga kestabilan suatu 

pekerjaan. Tujuan penelitian adalah untuk meng-identifikasi tingkat hubungan faktor-faktor yang 

mempengaruhi efektivitas kerja karyawan dan meengurutkan faktor yang paling tinggi 

mempengaruhi efektivitas menurut karyawan-karyawan PT. Taisei-Pulauintan di proyek Two Seno 

Apartemen. Metodologi penelitian yang digunakan dalam penelitian adalah metode kuantitatif 

dengan menggambarkan hasil data responden yang telah dibagikan dalam kuesioner serta 

menganalisis data tersebut untuk mencapai hasil yang dapat menjawab tujuan penelitian. 

Penelitian menggunakan pengujian korelasi untuk mencari tingkat hubungan antara faktor-faktor 

dengan efektivitas kerja karyawan. Penelitian juga menggunakan pengujian kepentingan relatif 

indeks untuk mengetahui tingkat-tingkat faktor yang paling tinggi mempengaruhi sampai yang 

paling rendah terhadap efektivtas kerja karyawan. Dari hasil analisis pengujian korelasi dan uji 

kepentingan relatif indeks (IKR) dapat diketahui bahwa faktor jumlah dan komposisi tenaga kerja 

memiliki hubungan paling kuat dan faktor frekuensi kerja lembur memiliki nilai faktor paling 

tinggi terhadap efektivitas kerja karyawan. 

 

Kata kunci: kinerja karyawan, efektivitas perusahaan, hubungan korelasi, 

kepentingan relatif indeks  

 

Referensi: 27 (2008-2023) 
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ABSTRACT 

 

Yoel Chaeruman (1910107009) 

Analisis Faktor-Faktor yang Mempengaruhi Efektivitas Kerja Karyawan 

Pada PT. Taisei- Pulauintan Proyek Two Sen 

(xiv+80 halaman; 17 gambar; 20 tabel; 10 lampiran) 

 
Effectiveness of employee work at PT. The Pulauintan Two Seno Apartment project has a big 

influence on the performance carried out in the field. Therefore, monitoring of factors that can 

influence employee work effectiveness performance must be considered in order to ensure that 

employee work effectiveness does not decrease and maintain the stability of a job. The aim of the 

research is to identify the level of relationship between factors that influence employee work 

effectiveness and rank the factors that most influence effectiveness according to PT employees. 

Pulauintan in the Two Seno Apartment project. The research methodology used in the research is a 

quantitative method by describing the results of respondent data that have been distributed in the 

questionnaire and analyzing the data to achieve results that can answer the research objectives. 

The research uses correlation testing to find the level of relationship between factors and employee 

work effectiveness. The research also uses relative importance index testing to determine the levels 

of factors that have the highest to the lowest influence on employee work effectiveness. From the 

results of the correlation test analysis and the relative importance index (IKR) test, it can be seen 

that the number and composition of the workforce have the strongest relationship and the 

frequency of overtime work has the highest factor value on employee work effectiven
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BAB 1 

PENDAHULUAN 

1.1 Latar Belakang 

Efektivitas sumber daya manusia atau karyawan adalah salah satu faktor penentu 

keberhasilan dari sebuah perusahaan atau usaha. Kemampuan atau Efektivitas 

tenaga kerja tidak hanya ditentukan dari kinerja individu karyawan tersebut, tetapi 

kinerja Perusahaan secara keseluruhan juga mempunyayi dampak yang dapat 

menentukan kinerja karyawan dalam mengerjakan suatu pekerjaan.  

Efektivitas kerja karyawan menjadi nilai ukur terhadap sebuah pekerjaan dalam 

Perusahaan. Perusahaan sendiri tidak dapat berjalan tanpa adanya karyawan di 

dalamnnya. Karyawan yang memiliki Efektivitas kerja yang baik akan 

memberikan konstribusi yang lebih banyak daripada karyawan dengan Efektivitas 

kerja yang buruk. Maka dari itu, Perusahaan harus dapat mempertahankan atau 

meningkatkan Efektivitas kerja karyawan dengan cara mempertahankan atau 

meningkatkan faktor – faktor perubahanan Efektivitas kerja karyawan. 

Oleh sebab itu, pengawasan faktor – faktor ini bertujuan untuk mengukur faktor 

yang mempengaruhi Efektivitas kerja karyawan. Hal ini dapat mencegah adanya 

penurunan Efektivitas kerja karyawan – karyawan di PT. Pulau Intan khususnya di 

dalam Proyek Two Seno. 

Contoh kasus yang terjadi ada di dalam proyek Two Seno yang akan dibahas 

dicangkup di dalam penelitian ini. Faktor organisasi yaitu keterlambatan 

pembayaran terhadap pekerja menyebabkan keterlambatan proyek yang 

berlangsung sehingga mengharuskan Project Manager memajukan beberapa 

pekerjaan untuk mengejar kontrak yang sudah ditetapkan. 
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1.2 Rumusan Masalah 

Berdasarkan latar belakang yang tertera dan dijelaskan diatas, maka rumus 

permasalahan yang didapatkan adalah: 

a. Apa saja faktor yang dapat mempengaruhi Efektivitas kerja karyawan di 

perusahaan PT. Taisei-Pulauintan proyek Two Seno? 

b. Bagaimana hubungan faktor yang mempengaruhi Efektivitas kerja 

karyawan terhadap produktivitas perusahaan di PT. Taisei-Pulauintan 

proyek Two Seno? 

 

1.3 Tujuan Penelitian 

Dalam proses pelaksanaan penelitian yang dilakukan maka didapatkan tujuan 

penelitian untuk menjawab perumusan masalah, yaitu: 

a. Mendapatkan hasil faktor – faktor yang dapat mempengaruhi efektivitas 

kerja karyawan di PT. Taisei-Pulauintan proyek Two Seno. 

b. Mengetahui hubungan antara faktor yang mempengaruhi efektivitas kerja 

karyawan terhadap produktivitas perusahaan di PT. Taisei-Pulauintan 

proyek Two Seno berdasarkan jawaban. 

 

1.4 Manfaat Penelitian 

Penelitian Tugas Akhir ini memiliki manfaat yang berupa: 

a. Mengetahui faktor – faktor yang dapat mempengaruhi efektivitas kerja 

karyawan di PT. Taisei-Pulauintan proyek Two Seno. 
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b. Mendapatkan hasil penelitian yang dapat dimanfaatkan sebagai saran 

dalam mengevaluasi efektivitas kinerja karyawan PT. Taisei-Pulauintan di 

Proyek Two Seno. 

 

1.5 Ruang Lingkup Penelitian 

Untuk membuat penelitian yang dilakukan menjadi lebih mudah maka penelitian 

ini diberikan batasan ruang lingkup, diantaranya yaitu: 

a. Penelitian ini hanya berfokus di dalam PT. Taisei-Pulauintan proyek Two 

Seno di daerah Jakarta Selatan, Senopati Center Business District (SCBD). 

b. Metode yang digunakan di dalam penelitian ini merupakan metode 

kuantitatif yang merupakan evaluasi dan penjelasan hasil pengolahan dan 

analisis data. 

c. Metode analisis dan pengolahan data menggunakan metode pencarian nilai 

Korelasi dan uji Indeks Kepentingan Relatif menggunakan aplikasi SPSS. 

 

1.6 Sistematika Penulisan 

BAB 1 Pendahuluan 

Bab pendahuluan berisi tentang latar belakang atau gambaran umum proyek 

penelitian yang diinginkan, biasanya meliputi latar belakang, rumusan masalah, 

tujuan penelitian, manfaat penelitian, ruang lingkup penelitian, dan struktur 

deskriptif. 

 

BAB 2 Tinjauan Pustaka 
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Bab tinjauan Pustaka berisi catatan penjelasan. Penjelasan umum tentang prinsip-

prinsip teoritis yang relevan dengan penelitian, yang berasal dari jurnal, buku, dan 

peraturan, untuk dijadikan acuan diskusi yang mengarah pada penyelesaian tujuan 

penelitian ini.. 

 

BAB 3 Metode Penelitian 

Bab metode penelitian meliputi metode pengumpulan data, pengolahan data dan 

metode inferensi data yang diolah untuk menjawab rumusan pertanyaan penelitian 

ini. 

 

BAB 4 Analisis dan Pembahasan 

Bab analisis dan pembahasan berisikan tentang hasil dari pengujian-pengujian 

yang telah dilakukan dan bertujuan untuk mendapatkan hasil yang dapat 

menjawab perumusan permasalahan dalam penelitian ini. 

 

BAB 5 Kesimpulan dan Saran 

Bab kesimpulan dan saran berisikan tentang perincian hasil yang didapatkan oleh 

penulis pada bab 4 dan sebuah saran yang dapat menjadi manfaat penelitian serta 

saran untuk penelitian selanjutnya.  
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BAB 2 

TINJAUAN PUSTAKA 

2.1  Efektivitas Karyawan 

Menurut (Syaifuddin, 2018), efektivitas kinerja karyawan adalah elemen yang 

berkaitan atau terikat erat terhadap sifat dan tingkah laku seseorang. Maka, dapat 

dikatakan bahwa Efektivitas dapat berubah sewaktu-waktu dan terpengaruh 

terhadap sikap atau tingkah laku seseorang. Dengan keadaan penuh sadar, 

seseorang memiliki kehendak penuh untuk meningkatkan atau bahkan 

menurunkan produktivitasnya dalam melakukan sesuatu. 

Pengertian efektivitas kerja menurut (Sedarmayanti, 2021) bahwa efektivitas kerja 

karyawan dapat diartikan sebagai hasil perbandingan terbaik antara hasil yang 

dihasilkan dengan kegiatan yang dilakukan oleh seseorang. Bekerja dengan efektif 

dapat diartikan bekerja dan menghasilkan hasil sebesar mungkin dengan gerakan, 

usaha dan waktu pengerjaan sedikit mungkin. Hasil perbandingan ini dapat 

meningkat dengan adanya bantuan penggunanaan alat kerja yang dapat membantu 

mempercepat penyelesaian tugas atau suatu pekerjaan. Alat kerja juga dapat 

menjadi alat bantu untuk menghemat pergerakan dari seseorang sehingga 

seseorang dapat bekerja secara efisien. Memiliki nilai efektivitas karyawan yang 

tinggi adalah elemen kunci sebuah perusahaan sukses. Dalam pelaksanaan 

pekerjaan sering dijumpai kendala-kendala yang dapat mempengeruhi efektivitas 

kerja karyawan dan kelancaraan suatu pekerjaan. Diantaranya dapat berupa sistem, 

prosedur perusahaan atau cara kerja seseorang yang dinilai kurang efisien dalam 

melaksanaan pekerjaan yang diberikan. 
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Menurut (Mulyadi, Sistem Akuntasi, 2020) efektivitas sering dikaitkan dengan 

kinerja suatu atau sebuah perusahaan karena efektivitas diartikan sebagai 

perbandingan antara hasil yang diperoleh (output) dengan usaha yang diberikan 

(input). Efektivitas dikatakan juga sering dikaitkan dengan produktivitas yang 

dihasilkan karena sama-sama memiliki nilai variabel-variabel output dan input. 

Produktivitas dihitung dengan membagi output dengan input. Sedangkan, 

Efektivitas dihitung dengan membagi input dengan output. 

Berdasarkan pengertian yang dikatakan diatas, maka efektivitas kinerja karyawan 

dapat disimpulkan sebagai hasil perbandingan atau pembagian dari nilai input 

dengan output. Semakin kecil hasil perbandingan input dengan output maka 

semakin tinggi Efektivitas karyawan dari seseorang, atau dapat dikatakan juga 

bahwa semakin kecil usaha yang diberikan tetapi semakin besar hasil yang 

dihasilkan maka dapat dikatakan seseorang tersebut memiliki nilai Efektivitas 

yang tinggi. Oleh sebab itu perusahaan harus melakukan manajemen terhadap 

karyawan-karyawan untuk mengukur faktor-faktor yang dapat mempengaruhi 

efektivitas karyawan dalam suatu perusahaan. Efektivitas karyawan meningkat 

atau tercapai secara signifikan bila didukung oleh karakteristik pribadi, komitmen 

kerja, dan dukungan organisasi perusahaan. Atribut pribadi mencakup faktor 

pribadi seperti keterampilan, kemampuan, dan latar belakang pendidikan. Usaha 

kerja berkaitan dengan keinginan untuk mencapai sesuatu. Di sisi lain, dukungan 

organisasi dapat mencakup unsur sumber daya, kepemimpinan, lingkungan kerja, 

struktur organisasi, dan desain kerja  (Syaifuddin, 2018). 
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2.2 Produktivitas Karyawan 

Produktivitas merupakan salah satu faktor kunci untuk sebuah perusahaan agar 

dapat dapat mencapai tujuannya. Jika produktivitas kerja karyawan terus 

meningkat dari waktu ke waktu, maka perusahaan dapat dengan mudah mencapai 

tujuannya. 

Saat ini, untuk dapat bertahan dalam persaingan antar perusahaan yang semakin 

ketat, kami terus berupaya meningkatkan kualitas karyawan dan produktivitas 

kerja. Produktivitas kerja karyawan dapat dipengaruhi oleh banyak faktor, antara 

lain kemampuan mental dan fisik pegawai, hubungan atasan dan bawahan, serta 

motivasi. Produktivitas diartikan sebagai hasil pengukuran kinerja yang 

memperhitungkan produktivitas kerja seorang karyawan. Sumber daya yang 

digunakan meliputi sumber daya manusia, pelatihan, disiplin kerja, keterampilan, 

sikap, dan lingkungan kerja karyawan. Berdasarkan pengertian para ahli dapat 

disimpulkan bahwa produktivitas merupakan pola pikir pegawai sehingga dapat 

mencerminkan kemampuannya dalam bekerja (Pambudianto, 2017). 

 

2.2  Faktor-Faktor Mempengaruhi Efektivitas Karyawan 

Organisasi adalah sekelompok orang yang mempunyai kemampuan yang berbeda-

beda dan umumnya saling bergantung yang mempunyai tujuan yang sama untuk 

mencapai tujuan yang ingin dicapai dengan memanfaatkan sumber daya manusia 

yang berbeda-beda.  

Pada dasarnya, sebuah organisasi memiliki tujuan yang sama yaitu mencari 

keuntungan. Oleh karena itu, memiliki karyawan atau sumber daya dengan efisien 

yang tinggi adalah kunci elemen suksesnya suatu organisasi, dengan kata lain 
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mengeluarkan sesedikit mungkin usaha atau menghemat energi dan waktu dan 

menghasilkan output yang besar sehingga keuntungan yang diperoleh pun besar 

(Simanjuntak & Payaman, 2020) mengatakan, Efektivitas kerja karyawan dapat 

dipengaruhi olehg banyak faktor yang telah digolongkan menjadi 3 golongan, 

yaitu: 

a. Kompetensi5Individu 

b. Dukungan5Organisasi 

c. Dukungan5Manajemen 

2.2.1  Kompetensi Individu 

Kompetensi pribadi merupakan kemampuan atau keterampilan yang dibutuhkan 

seseorang untuk menyelesaikan suatu tugas. Kemampuan seseorang sendiri 

dipengaruhi oleh berbagai macam faktor antara lain keterampilan, pendidikan, 

pelatihan, kondisi fisik, dan riwayat pekerjaan. Faktor-faktor tersebut di atas 

mempunyai dampak yang unik terhadap kinerja seseorang dan dapat 

mempengaruhi efektivitas kerja seorang pegawai. 

2.2.2  Dukungan Organisasi 

Efektivitas Kerja Karyawan dapat juga dipengaruhi oleh faktor-faktor dukungan 

suatu organisasi seperti penyediaan sarana dan prasarana di tempat kerja, kondisi 

tempat kerja, serta syarat-syarat yang berlaku di dalam tempat kerja. Hal ini 

berkaitan juga dengan penyediaan alat-alat kerja yang dapat membantu proses 

kerja seorang karyawan dan membantu meningkatkan Efektivitas karyawan. 

Kondisi tempat kerja meliputi kenyamanan lingkungan kerja dan dapat diukur dari 

aspek-aspek seperti keselamatan dan kesehatan lingkungan kerja, sistem 

pengupahan, jaminan sosial, serta hubungan harmonis antara pekerja dan atasan di 
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lingkungan kerja. Perusahaan yang baik sudah seharusnya mempunyai program 

kesehatan dan keselamatan kerja yang baik di lingkungan kerjanya untuk 

menghindari terjadinya kecelakaan di lingkungan kerja yang dapat mempengaruhi 

produktivitas lingkungan kerja. 

Syarat-syarat kerja meliputi hak dan kewajiban pekerja dalam lingkungan kerja. 

Kondisi kerja yang baik dimaksudkan untuk memudahkan pekerjaan karyawan 

dan menciptakan tingkat efisiensi yang tinggi. Struktur pengupahan yang sesuai 

dengan kontrak kerja juga dapat membuat pekerja menjadi lebih efisien, 

dibandingkan dengan struktur pengupahan yang lebih cenderung terlambat dan 

mempengaruhi produktivitas pekerja. 

2.2.3  Dukungan Manajemen 

Efisien dan penghematan tenaga kerja atau sumber daya manusia merupakan 

Langkah selanjutnya untuk menciptakan nilai efisien karyawan yang tinggi. Maka 

dari itu, perusahaan diharapkan memiliki sistem manajamen atau pemimpin yang 

baik untuk meng-control karyawan sehingga dapat mendapatkan nilai Efektivitas 

yang tinggi dari karyawan tersebut. 

Menurut (Gani & Achmad, 2019) faktor-faktor dukungan manajemen yang 

mempengaruhi Efektivitas kerja karyawan adalah sebagai berikut: 

a. Profesionalisme yang diukur dari pendidikan, pelatihan, pengalaman kerja 

seseorang dan tersedianya alat kerja di dalam lingkungan kerja. 

b. Disiplin dari karyawan yang diukur terhadap jam waktu kerja, ketaatan 

terhadap aturan yang berlaku, jadwal dan pelaksanaan pekerjaan. 

c. Motivasi kerja yang diukur dari kesehjateraan, penghargaan yang diberikan, 

kondisi lingkungan dan ruangan kerja. 
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2.3 Tenaga Kerja 

Angkatan tenaga kerja yang mengacu pada penduduk usia kerja (15 hingga 64 

tahun), atau jumlah penduduk suatu negara yang mampu memproduksi barang 

dan jasa bila diperlukan dan bersedia berpartisipasi dalam kegiatan tersebut. 

Pertumbuhan penduduk dalam negara memiliki ketergantungan pada jumlah 

tenaga kerja dan merupakan salah satu faktor penting dalam hal produksi di 

sebuah perusahaan. Oleh karena itu, jumlah pekerja yang bekerja pun akan 

semakin meningkat dari tahun ke tahun. Meningkatnya jumlah tenaga kerja setiap 

tahunnya dapat memberikan dampak positif maupun negatif tergantung peran 

mereka sebagai tenaga kerja dalam sebuah perusahaan. Sehingga, faktor-faktor 

tenaga kerja di dalam sebuah perusahaan harus diperhatikan agar dapat 

memberikan hasil yang maksimal dalam sebuah perusahaan (Mulyadi, 2014). 

Indikator-indikator yang memiliki peran dalam faktor tenaga kerja adalah: 

1. Umur Tenaga Kerja 

2. Pengalaman dan Keahlian Tenaga Kerja 

3. Disiplin Tenaga Kerja 

4. Kondisi Kesehatan Tenaga Kerja 

 

2.4 Manajemen 

Manajemen kerja adalah salah satu konsep paling mendasar dan penting dalam 

bisnis, organisasi, dan kehidupan sehari-hari. Manajemen adalah ilmu dan seni 

yang berkaitan dengan pengorganisasian, pengarahan, dan pengkoordinasian 

sumber daya manusia dan nonmanusia untuk mencapai tujuan tertentu. 

Manajemen memiliki peran sebagai pedoman untuk mencapai tujuan dan visi 
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yang telah ditentukan oleh sebuah usaha atau perusahaan. Definisi sederhana 

manajemen adalah seni dan ilmu perencanaan, pengorganisasian, pengarahan, dan 

pengelolaan sumber daya untuk mencapai tujuan tertentu. Dengan kata lain, 

manajemen adalah serangkaian proses yang kompleks, namun pada hakikatnya 

tujuannya adalah untuk mengoptimalkan penggunaan sumber daya yang terbatas 

untuk mencapai hasil maksimal yang diinginkan. Manajemen dapat diterapkan 

tidak hanya pada organisasi dan bisnis besar, tetapi juga pada berbagai situasi 

seperti lingkungan pribadi, keluarga, dan bahkan proyek kecil. Manajemen yang 

baik sangat diperlukan di perusahaan multinasional, pemilik usaha kecil, atau 

individu yang berusaha mencapai hasil dan keuntungan yang maksimal (Elvis M. 

C. Lumingkewas, 2023). Indikator-indikator yang memiliki peran dalam faktor 

manajemen adalah: 

1. Manajemen kepemimpinan dan keterampilan. 

2. Komunikasi yang baik antara pekerja, mandor, supervisor, pengawas dan 

pengelola lokasi. 

3. Perhatian terhadap karyawan yang sedang bekerja. 

4. Perencanaan yang sudah matang dan penjadwalan yang tepat. 

 

2.5 Motivasi 

Motivasi adalah kekuatan yang mendorong individu atau anggota tim untuk 

mengerahkan bakat, pengetahuan, waktu, dan tenaganya untuk melakukan 

berbagai tugas yang menjadi tanggung jawabnya dan memenuhi kewajibannya 

untuk mencapai tujuan organisasi. Dengan kata lain, motivasi dalam bekerja 

adalah segala faktor yang membangkitkan semangat, keinginan, hasrat, dan tenaga 
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seseorang serta mempengaruhi, mengarahkan, dan mendukung perilakunya untuk 

mencapai tujuan yang diinginkan tergantung pada ruang lingkup pekerjaannya. 

Karyawan yang memiliki nilai motivasi tinggi akan melakukan pekerjaannya 

dengan lebih baik. 

Karyawan yang mempunyai sikap positif dan positif terhadap lingkungan kerja, 

selanjutnya didorong untuk memberikan yang terbaik. Motivasi ini mendorong 

karyawan untuk menggunakan pikiran dan tenaganya untuk mencapai tujuan 

perusahaan. Karena itu, motivasi adalah sebuah faktor yang berperan penting 

dalam sebuah perusahaan untuk menjaga kinerja dari karyawan-karyawannya 

(Kurniasari & Rosdiana, 2023). Indikator-indikator yang berperan dalam faktor 

motivasi adalah: 

1. Besar atau kecilnya upah seorang pekerja. 

2. Ketetapan dan keterlambatan pembayaran gaji seorang pekerja. 

3. Jaminan-jaminan yang diberikan kepada seorang pekerja (Contohnya 

jaminan kecelakaan). 

 

2.6 Pelaksanaan Proyek 

Pelaksanaan proyek atau implementasi proyek merupakan gabungan berbagai 

sumber daya  yang dikumpulkan ke dalam wadah organisasi sementara untuk 

mencapai tujuan tertentu. Kegiatan dan tugas yang dilakukan dalam suatu proyek 

dapat berupa pekerjaan konstruksi/perbaikan fasilitas (gedung, jalan, jembatan, 

bendungan, dan lain-lain) atau  kegiatan penelitian dan pengembangan. 

Berdasarkan uraian di atas, pelaksanaan proyek merupakan suatu proyek yang 

bersifat sementara (waktu terbatas), satu kali saja, bersifat non-finansial dengan 
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waktu mulai dan berakhir, sumber daya yang terbatas/spesifik, dan ditujukan 

untuk mencapai tujuan yang telah ditetapkan, merupakan kegiatan sehari-hari. 

Karena itu, sebuah pelaksanaan proyek harus memiliki perencanaan yang sudah 

matang dan siap untuk dilaksanan di lapangan agar tidak menciptakan kesahalan 

yang tidak diinginkan dan mendapatkan hasil yang sudah diharapkan (Pramana, 

2022). Indikator-indikator yang memiliki peran dalam faktor pelaksanaan proyek 

adalah: 

1. Banyaknya jumlah pekerja dalam sebuah perusahaan. 

2. Ketersiadaan dan perletakan gedung penyimpanan material dan alat. 

3. Ketetapan penjelasan mengenai pekerjaan dari perusahaan terhadap 

seorang pekerja. 

 

2.7 Eksternal 

Lingkungan eksternal merupakan faktor-faktor di luar kendali perusahaan yang 

dapat menciptakan peluang atau ancaman bagi perusahaan. Lingkungan eksternal 

adalah lingkungan organisasi luaran yang mempengaruhi peluang organisasi. 

Jadi, bisa disimpulkan lingkungan eksternal adalah lingkungan di mana satu unit 

perusahaan berinteraksi langsung dengan elemen-elemen di sekitarnya, sehingga 

berdampak langsung pada kinerja karyawan di perusahaan. Oleh karena itu, faktor 

eksternal harus dipertimbangkan untuk menjaga kestabilan kinerja karyawan.(Rini, 

2019). Indikator-indikator yang berperan dalam faktor eksternal adalah: 

1. Kondisi politik yang sedang terjadi dan pertumbuhan ekonomi. 

2. Peraturan dan perundang-undangan yang tertera. 
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3. Kondisi lingkungan sekitar, sosial danbudaya yang diterapkan di wilayah 

sekitar proyek. 

 

2.8 Material dan Peralatan 

Material adalah sesuatu yang dihasilkan atau dibuat dari bahan. Material merujuk 

pada bahan baku yang diolah oleh perusahaan industri dan bisa didapatkan 

melalui pembelian lokal, impor, atau pengolahan sendiri. Dari penjelasan tersebut, 

dapat disimpulkan bahwa material adalah bahan yang digunakan dalam proses 

pembuatan produk akhir atau produk yang lebih berguna. 

Bahan-bahan yang dibutuhkan direncanakan dan dikelola berdasarkan perkiraan 

rencana pelaksanaan pekerjaan. Perencanaan material dan peralatan meliputi 

perkiraan kebutuhan setiap material, menetapkan anggaran material, 

memperkirakan tingkat persediaan, merencanakan pesanan material, dan 

memantau produksi dan kinerja dari karyawan di dalam sebuah perusahaan 

(Aditya, 2019). maka dari itu, pemanantuan material dan peralatan dalam sebuah 

perusahaan harus memiliki pemantaun yang baik agar tidak terjadi mogok kerja 

karena kekurangan material dan peralatan dalam sebuah proyek. Faktor-faktor 

yang dapat dimasukkan kedalam material dan peralatan adalah sebagai berikut: 

1. Kondisi dan kualitas peralatan. 

2. Kecukupan jumlah peralatan di lapangan. 

3. Kondisi dan kualitas material. 

4. Cukup atau tidaknya ketersidaan material di lapangan. 
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2.9 Lingkungan dan Kondisi Kerja 

Lingkungan kerja adalah kombinasi dari alat, bahan, metode kerja, dan pengaturan 

kerja yang ditemui orang-orang dalam lingkungan kerja, baik secara individu 

maupun kelompok. Lingkungan kerja juga merupakan hal yang sangat penting 

dalam aktivitas karyawan. Oleh karena itu, perusahaan yang menciptakan 

lingkungan kerja yang kondusif dan kondisi kerja yang memotivasi karyawan 

akan mempengaruhi prestasi kerja mereka.. 

Dalam kata-kata yang sederhana, lingkungan kerja adalah segala sesuatu yang ada 

di sekitar seorang pekerja dalam pekerjaannya, baik fisik maupun non-fisik, 

langsung atau tidak langsung, yang mempengaruhinya. Maka dari itu sebuah 

perusahaan harus memerhatikan pandangan karyawan terhadap lingkungan kerja 

mereka agar tidak menghambat kinerja karyawan (Marisya, 2022). Indikator-

indikator yang memiliki peran pengaruh terhadap faktor lingkungan kerja adalah: 

1. Luas atau sempitnya area kerja bagi pekerja dalam sebuah perusahaan. 

2. Tata letak lokasi bekerja untuk para pekerja. 

3. Sehat atau tidaknya kondisi fisik dari tempat bekerja bagi pekerja di 

sebuah perusahaan. 

 

2.10 Teknis 

Teknis adalah suatu cara untuk menciptakan atau melakukan sesuatu yang 

berhubungan dengan seni (seperti kepintaran), suatu metode atau sistem untuk 

melakukan sesuatu. Dengan kata lain, teknis adalah proses logis dan rasional 

dalam merancang sekumpulan komponen yang saling terkait dengan 



 

16 

 

tujuan ...yang mempengaruhinya dan berfungsi sebagai satu kesatuan untuk 

mencapai tujuan yang telah ditentukan.  (Abian, 2018). 

Menurut penjelasan diatas, teknis dapat diartikan sebagai metode yang digunakan 

dalam sebuah pekerjaan untuk mencapai tujuan yang diinginkan. Teknis juga 

dapat berpengaruh terhadap keselamatan dari karyawan dan kelancaran kinerja 

karyawan dalam suatu pekerjaan. Maka dari itu, teknis yang memiliki metode 

mudah dipahami dapat mempercepat kinerja karyawan. Indikator-indikator yang 

memiliki peran dalam faktor teknis adalah: 

1. Sulit atau tidaknya sebuah pekerjaan yang diberikan. 

2. Ketetapan sebuah desain atau metode pekerjaan yang konsisten. 

3. Metode dan teknologi konstruksi. 

 

2.11 Waktu 

Waktu yang dimaksud didalam penelitian adalah jumlah penggunaan waktu yang 

disediakan untuk para karyawan dalam sebuah perusahaan. Pemberian dan 

penggunaan waktu dapat mempengaruhi kinerja seorang karyawan di dalam 

sebuah perusahaan (Nugroho, 2020). Maka dari itu sebuah perusahaan harus 

menentukan jadwal waktu yang sesuai dengan aturan dan kekuatan karyawan 

dalam pekerjaannya. Faktor-faktor yang dimaksud dalam faktor waktu ini adalah 

sebagai berikut: 

1. Frekuensi jumlah kerja lembur bagi pekerja. 

2. Ketetapan waktu datang, istirahat dan pulang seorang pekerja. 

3. Ketersiadaan jadwal istirahat yang dinilai cukup bagi seorang pekerja. 
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2.12 Keselamatan Kerja 

Keselamatan dan Kesehatan Kerja (K3) adalah upaya meminimalkan risiko 

kecelakaan dan penyakit yang diakibatkan oleh kerja, dan pada dasarnya 

keselamatan dan kesehatan tidak bisa dipisahkan. Penerapan K3 adalah salah satu 

cara untuk menciptakan tempat kerja yang nyaman dan sehat, mencegah 

pencemaran lingkungan, serta mengurangi kecelakaan kerja dan penyakit akibat 

kerja, yang pada akhirnya meningkatkan keselamatan kerja. (Hariny, 2022). 

Dengan kata lain, keselamatan Kerja (K3) dapat diartikan melindungi pekerja atau 

anggota masyarakat untuk menjaga tingkat kesehatan fisik, mental dan sosial yang 

setinggi-tingginya dalam suatu perusahaan, dan untuk mencegah penyakit dan 

penyakit yang disebabkan oleh faktor terkait pekerjaan, lingkungan kerja, dan 

penyakit pada umumnya. Maka dari itu, pengawasan dan perlengkapan 

keselamatan kera (K3) dalam sebuah proyek harus ditekankan agar kinerja 

karyawan tetap stabil dan baik. Faktor-faktor yang dimaksud di dalam 

keselamatan kerja adalah sebagai berikut: 

1. Kedisiplinan terhadap pelaksanaan dan keselamatan kerja 

2. Ketersiadaan peralatan keselamatan kerja 

3. Ketersidaan rambu-rambu keselamatan kerja 

 

2.13 Perusahaan 

Usaha merujuk pada tempat di mana barang atau jasa diproduksi. Semua faktor 

produksi, seperti tenaga kerja, modal, sumber daya alam, dan kewirausahaan, 

bergabung dalam suatu entitas perusahaan. Definisi lainnya mencakup lembaga 

atau organisasi yang menawarkan barang atau jasa untuk dijual kepada 
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masyarakat dengan tujuan memperoleh keuntungan. Perseroan, seperti yang diatur 

dalam Undang-Undang Nomor 3 Tahun 1982 tentang Wajib Daftar Perusahaan, 

dijelaskan sebagai badan usaha yang didirikan dan dioperasikan untuk mencari 

keuntungan di wilayah Negara Kesatuan Republik Indonesia. (NKRI) (Vedhitya, 

2022). 

Perusahaan harus memiliki perencanaan dahulu untuk memutuskan jenis bisnis 

apa yang ingin mereka dirikan.  Jenis Perusahaan bisa Perorangan,5UKM,5CV, 

atau5PT. Jenis perusahaan ini dapat berubah seiring berkembangnya perusahaan. 

Hal ini memberikan kebebasan bagi perusahaan untuk menentukan jenis usaha 

apa yang ingin dijalankan. 

2.13.1 Perseroan Terbatas (PT) 

Perseroan Terbatas (PT) adalah entitas hukum yang menjalankan perusahaan 

dengan modal yang terdiri dari saham-saham. Saham-saham ini dapat 

diperdagangkan, memungkinkan kepemilikan perusahaan berubah tanpa 

membubarkan perusahaan. PT adalah perusahaan dengan modal yang besar yang 

sudah ditetapkan dalam anggaran dasar. Keuntungan perusahaan terpisah dari 

keuntungan pribadi pemiliknya, sehingga pemilik menikmati keuntungan secara 

individu. Setiap individu dapat memiliki beberapa saham untuk menunjukkan 

kepemilikannya. 

Pemegang saham bertanggung jawab terbatas sesuai dengan jumlah saham yang 

mereka miliki. Jika hutang PT melebihi keuntungan PT, pemegang saham tidak 

bertanggung jawab atas hutang tersebut. Ketika PT menghasilkan keuntungan, 

keuntungan itu akan dibagikan sesuai dengan peraturan yang telah ditetapkan. 

Pemegang saham menerima bagian dari keuntungan tersebut dalam bentuk 
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dividen, yang jumlahnya tergantung pada besarnya keuntungan yang dihasilkan 

oleh PT. 

2.13.2 Joint Operation 

Joint Operation atau kerja sama operasional didefinisikan sebagai usaha kerja 

sama yang terdiri dari beberapa badan usaha yang bekerja sama dalam operasional 

untuk bersama – sama menyelesaikan proyek yang sama. Joint Operation ini 

biasanya bersifat sementara. 

Joint Operation merupakan salah satu perjanjian yang tidak bernama atau dapat 

juga disebut dengan istilah “Persekutuan Perdata” (Sujoko, 2020). 

 

2.14 Metode Kuantitatif 

Penelitian kuantitatif dalam pengertian yang lebih khusus mengacu pada 

penelitian yang menggunakan data berupa angka, dimulai dari proses 

pengumpulan data, analisis data, hingga interpretasi data. Pendekatan kuantitatif 

mendasarkan analisisnya pada data numerik dan menggunakan teknik statistik 

yang sesuai. Biasanya digunakan untuk menguji hipotesis dan menghasilkan 

temuan yang dapat disajikan dalam bentuk hasil uji statistik yang menunjukkan 

signifikansi hubungan yang diteliti. Oleh karena itu, arah hubungan yang 

ditemukan didasarkan pada hipotesis dan analisis statistik, bukan hanya pada 

pertimbangan logis. Metode kuantitatif sering juga dikenal sebagai metode 

tradisional.(Prof. Dr. H.M. Sidik Priadana, 2021). 

Metode kuantitatif disebut metode tradisional dikarenakan metodenya yang sudah 

digunakan cukup lama dan sudah menjadi tradisi sevagai metode untuk sebuah 

penelitian. 
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2.15 Uji Validitas 

Pengujian validitas digunakan untuk melihat apakah pertanyaan-pertanyaan yang 

digunakan di dalam penelitian ini memiliki nilai valid atau tidak valid, penulis 

menggunakan pengujian validitas dengan bantuan SPSS (Statistical Product and 

Service Solutions). 

2.15.1  Pengertian Uji Validitas 

Uji Validitas adalah proses pengujian yang bertujuan untuk menentukan apakah 

alat pengukur yang digunakan dalam penelitian memiliki nilai yang valid atau 

tidak. Alat pengukur yang dimaksud adalah kuesioner yang berisi pertanyaan-

pertanyaan yang akan didistribusikan kepada responden. Menurut Janna (2021), 

sebuah kuesioner dianggap valid jika pertanyaan-pertanyaan yang tercantum di 

dalamnya dapat mengukur sesuatu yang diinginkan sesuai dengan tujuan 

kuesioner tersebut. Terdapat dua jenis uji validitas: pertama, mengkorelasikan 

nilai suatu pertanyaan dengan total skor kuesioner; kedua, mengkorelasikan 

masing-masing indikator pertanyaan dengan total skor konstruk yang diukur. 

2.15.2 Kriteria Pengujian Validitas 

Dalam penelitian ini, dilakukan uji validitas yang menghubungkan setiap skor 

pertanyaan dengan total skor konstruk. Signifikansi yang digunakan dalam 

penelitian ini adalah 0,05. Kriteria untuk menguji validitas adalah sebagai berikut: 
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Tabel 2. 1 Kriteria Pengujian Validitas 

Kriteria Syarat Kriteria 

Valid5 R Hitung5> R Tabel 

Tidak Valid5x R Statistik ≤ R5Tabel 

 Sumber : (Janna, 2021) 

Cara menentukan5besar5nilai5R5Tabel dituangkan di rumus berikut : 

R Tabel = df5(N-2), tingkat5signifikansi uji dua arah 

Catatan : 

N = Jumlah data yang diuji 

 

2.16 Uji Reliabilitas 

Reabilitas suatu instrumen dapat diuji menggunakan berbagai metode reliabilitas. 

Pengujian reliabilitas yang umum meliputi uji ulang, ekuivalen, dan konsistensi 

internal. Khususnya, konsistensi internal memiliki beberapa teknik pengujian 

yang berbeda, seperti uji Split Half, KR 20, KR 21, dan Cronbach’s Alpha. 

Dalam penelitian, reliabilitas diukur menggunakan perhitungan Alpha Cronbach. 

Metode ini digunakan untuk menilai seberapa reliabel suatu instrumen penelitian 

dengan asumsi bahwa jawaban responden dinyatakan dalam skala 1 hingga 5,. 

Reliabilitas tes diungkapkan dalam bentuk koefisien numerik. Koefisien yang 

tinggi menunjukkan tingkat reliabilitas yang tinggi, sedangkan koefisien rendah 

menunjukkan reliabilitas yang rendah (Indrajaya, 2023). Kriteria atau syarat-

syarat pengujian relabilitas dapat dilihat di tabel 2.2 dibawah berikut. 
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Tabel 2.2 Kriteria Pengujian Reliabilitas 

Cronbach Alpha Makna 

< 0,60 Reliabel Tidak Baik 

≥ 0,60 Reliabel Baik 

 Sumber : Hasil olah data primer, 2020 

 

2.17 Uji Normalitas 

Uji normalitas adalah prosedur yang bertujuan untuk menilai apakah data 

penelitian mengikuti distribusi normal atau tidak. Dalam penelitian ini, metode 

yang digunakan adalah uji One Sample Kolmogorov-Smirnov dengan 

menggunakan perangkat lunak IBM SPSS. Hasil dari pengujian ini akan 

menghasilkan hipotesis yang akan menentukan apakah data penelitian dapat 

dianggap mengikuti distribusi normal atau tidak (Ayun, 2019). Hipotesis5yang 

digunakan dalam penelitian5ini berupa: 

Ho = Data penelitian berdistribusi5normal 

Ha = Data penelitian tidak5berdistribusi5normal 

Adapun persyaratan dan peraturan yang digunakan untuk mengambil keputusan 

uji normalitas dengan metode One Sample Kolmogorv-Smirnov di penelitian ini 

adalah: 

a) Jika nilai5Asymp. Sig (2-tailed) > 0,05 maka5Ho diterima5dan Ha 

ditolak. Hal ini menjelaskan bahwa hipotesis data penelitian 

berdistribusi normal diterima. Sedangkan hipoteses data penelitian tidak 

berdistribusi normal tidak diterima. 
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b) Jika nilai5Asymp. Sig (2-tailed) < 0,05 maka5Ho ditolak5dan Ha 

diterima. Hal ini menjelaskan bahwa hipotesis data penelitian 

berdistribusi normal tidak diterima. Sedangkan hipotesis data penelitian 

tidak berdistribusi normal diterima. 

 

2.18 Uji Korelasi 

Pengujian korelasi adalah metode untuk menghitung koefisien yang membantu 

dalam menilai seberapa kuat hubungan antara dua variabel atau lebih. Menurut 

(Sanny & Dewi, 2020) Koefisien Pearson Product Moment digunakan untuk 

menguji hipotesis tentang adanya hubungan antara dua variabel dan menghasilkan 

nilai yang mengindikasikan seberapa kuat hubungan antara keduanya. Dalam 

penelitian ini, peneliti menggunakan perangkat lunak IBM SPSS untuk 

mengevaluasi hubungan dan kekuatan hubungan antara dua variabel, yaitu 

variabel X (Dependent) dan variabel Y (Independent). Tingkat 

hubungan5koefisien5korelasi dapat5dilihat5di tabel 2.3 dibawah berikut. 

Tabel 2. 3 Tingkat Hubungan Koefisien Korelasi 

Interval5Koefisien5 

Korelasi 
Tingkat5Hubungan 

0,005–50,199 Sangat5Lemah 

0,205–50,399 Lemah. 

0,405–50,599 Sedang. 

0,605–50,799 Kuat. 

0,805–51,000 Sangat Kuat. 

         Sumber: (Sanny & Dewi, 2020) 
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2.19 Uji Indeks Kepentingan Relatif (IKR) 

Pengujian indeks kepentingan relatif merupakan5salah satu5pengujian analisis 

data5yang bertujuan5untuk menentukan peringkat tiap variabel X yang 

mempengaruhi variabel Y (Celine Faustine, 2022). Pengujian kepentingan relatif 

indeks di penelitian ini dibantu menggunakan perangkat lunak Microsoft Excel. 

Rumus yang dapat digunakan untuk menentukan peringkat variabel X adalah 

sebagai berikut: 

IKR (%) =  
5(N5)+4(N4)+(3(N3)+2(N2)+ N1

W×(N55+ 5N45+ 5N35+ 5N25+ N1)
 

Ket : 

RII = Nilai5Indeks5Kepentingan5Relatif 

N5 = Jumlah responden5yang mengisi5skala 5 

N4 = Jumlah responden5yang mengisi5skala 4 

N3 = Jumlah responden5yang mengisi5skala 3 

N2 = Jumlah responden5yang mengisi5skala 2 

N1 = Jumlah responden5yang mengisi5skala 1 

W =5Skala terbesar dalam kuesioner 

Pengujian uji kepentingan relatif dapat juga digunakan untuk mengetahui level 

kepentingan dari suatu variabel X yang mempengaruhi variabel Y. Hipotesis ini 

dapat dilihat dari hasil nilai uji kepentingan relatif. Level kepentingan berdasarkan 

nilai hasil uji kepentingan relatif ini dapat dilihat di tabel 2.4 dibawh berikut: 

Tabel 2. 4 Rentang Nilai Uji Kepentingan Relatif 

Rentang5Nilai5RII Level5Kepentingan 

0,85≤ RII5≤ 1 High5(H) 

0,65≤ RII5≤ 0,8 High-Medium5(H-M) 
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Rentang5Nilai5RII Level5Kepentingan 

0,45≤ RII ≤50,6 Medium5(M) 

0,25≤ RII ≤50,4 Medium-Low5(M-L) 

05≤ RII ≤50,2 Low5(L) 

         Sumber: (Celine Faustine, 2022) 

 

2.20 Penelitian Terdahulu 

Hasil penelitian dari beberapa referensi sebelumnya dapat menjadi sumber 

inspirasi untuk menyusun penelitian baru atau menjadi topik penelitian yang akan 

diterapkan di lokasi proyek yang dipilih sebagai lokasi penelitian. Dalam konteks 

ini, penting untuk mengidentifikasi bahwa penelitian sebelumnya dapat 

dikelompokkan ke dalam beberapa kategori yang memberikan dasar yang kuat 

untuk penulisan penelitian saat ini. Kategori-kategori ini mencakup berbagai 

aspek yang relevan dengan tujuan penelitian yang sedang dilakukan. Oleh karena 

itu, penelitian sebelumnya dapat digunakan sebagai referensi dan perbandingan 

dalam penelitian ini, di mana penelitian sebelumnya dapat dibagi ke dalam 

kategori-kategori berikut: 
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Tabel 2.5 Penelitian Terdahulu 

No Judul 

Penulis 

dan 

Tahun 

Tujuan 

Penelitian 
Hasil 

1 

Analisis5Pengaruh 

Faktor-faktor 

Produktivitas5Kerja 

Proyek5Konstruksi 

Dengan5Relative 

Importance5Index 

(RII) dan5Regresi 

Linear5Berganda 

Noviyarsi, 

M. 

Nursyaifi 

Yulius, 

Yusrizal 

Bakar,5Ev

a Suryani 

(2023) 

Mengidentifikasi 

faktor yang paling 

berpengaruh 

terhadap 

produktivitas 

kerja proyek 

konstruksi 

Melampirkan data 

yang berisi tentang 

faktor-faktor yang 

paling berpengaruh 

terhadap 

produktivitas kerja 

proyek konstruksi 

2 

Konsep Uji Validitas 

dan Realibilitas 

Dengan 

Menggunakan SPSS 

Nilda 

Miftahul 

Janna 

(2021) 

Menjelaskan 

penggunaan 

perangkat lunak 

IBM SPSS untuk 

mengetahui nilai 

validitas dan 

reabilitas daripada 

instrumen 

kuesioner dalam 

sebuah penelitian 

Mengetahui nilai 

validitas dan 

reabilitas 

menggunakan 

perangkat lunak 

IBM SPSS sebagai 

tolak ukur 

instrumen 

kuesioner dalam 

sebuah penelitian 

3 

Peringkat5Faktor-

Faktor5yang 

Mempengaruhi 

Produktivitas Tenaga 

Kerja5Pada5Proyek 

Konstruksi 

Celine 

Faustine 

(2022) 

Menentukan 

peringkat faktor-

faktor5yang paling 

mempengaruhi 

produktivitas5tenag

a 

kerja5pada5proyek 

konstruksi 

Peringkat5faktor-

faktor5yang paling 

mempengaruhi5prod

uktivitas tenaga 

kerja5pada proyek 

konstruksi 

 

2.21 State of Art 

State of Art merupakan komponen penting dalam sebuah penelitian. State of art 

memberikan manfaat kepada peneliti untuk mengetahui perkembangan ilmu pada 

bidang tertentu yang digunakan dalam suatu penelitian. State of art biasanya 
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menggunakan penelitan terdahulu sebagai pengacu untuk membedakan hasil 

penelitian terdahulu dan penelitian yang sedang dilaksanakan. Penelitian 

terdahulu ini berguna untuk para peneliti sebagai bahan penelitian dengan inovasi 

yang baru. 

Hal yang membedakan hasil penelitian di dalam penelitian dengan penelitian 

terdahulu adalah, penelitian lebih berfokus untuk memberikan saran terhadap 

salah satu faktor yang hasilnya tertinggi pada penelitian ini dan mengidentifikasi 

hubungan faktor yang paling tinggi terhadap efektivitas kinerja karyawan. Lalu 

objek penelitian atau data responden yang didapatkan di dalam penelitian berasal 

dari perusahaan yang berbeda. 
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BAB 3 

METODOLOGI PENELITIAN 

 

3.1 Kerangka Penelitian 

Proses penelitian ini mencakup beberapa tahapan yang dirancang untuk 

menerapkan metodologi yang sistematis dan terstruktur. Tahap pertama adalah 

tahap persiapan, yang sebagian besar melibatkan studi literatur dari berbagai 

jurnal penelitian terkait topik yang akan diteliti. Informasi yang diperoleh dari 

tahap persiapan ini digunakan untuk menyusun kerangka penelitian atau kerangka 

kerja dan mengembangkan kalimat-kalimat yang akan dimasukkan dalam bab 

pertama, yaitu pendahuluan. Bab pendahuluan memiliki peran penting dalam 

menjelaskan dasar-dasar, latar belakang, dan konteks penelitian secara signifikan. 

Selanjutnya tahap kedua, dimana tahap ini berisikan tentang proses studi lapangan 

yang berguna untuk mengumpulkan data kuesioner terhadap karyawan-karyawan 

tentang faktor-faktor yang mempengaruhi Efektivitas karyawan tersebut. Data 

yang terkumpul akan dianalisis dengan menggunakan aplikasi SPSS untuk 

mencari nilai reabilitas dan validitas dari faktor-faktor yang disebutkan terhadap 

Efektivitas karyawan. Setelah pengumpulan data dan analisis data, hasil tersebut 

dapat digunakan sebagai rekomendasi untuk perusahaan PT. Taisei Pulauintan. 

Tahap ini merupakan langkah utama yang berfungsi untuk menghubungkan 

informasi dengan data yang telah dikumpulkan. Tahapan-tahapan tersebut 

membentuk rangkaian yang tidak hanya memberikan panduan dalam pelaksanaan 

penelitian, tetapi juga berguna untuk memastikan tujuan penelitian dapat tercapai 

dan terorganisir dengan baik. 
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Gambar 3. 1 Kerangka Penelitian 

Untuk membantu menjelaskan kerangka penelitian yang dibahas diatas, dapat 

dilihat pada diagram alir dibawah ini : 

 

 

Mulai 

Studi Literatur 

Validasi Awal 

A 

Pengumpulan Data Tahap I : 

- Survei 

- Wawancara 

 

-  

Analisis Data Tahap I : 

- Delphi’s Theory 

-  

Pengumpulan Data Tahap I : 

- Survei 

- Wawancara 

 

-  
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Gambar 3. 2 Kerangka Penelitian (Lanjutan) 

A 

Pengumpulan Data Tahap II : 

─ Survei 

─ Kuesioner 

Analisis Data Tahap II : 

─ Uji Validitas 

─ Uji Realibilitas 

─ Uji Normalitas 

─ Uji Korelasi 

─ Uji Indeks 

Kepentingan Relatif 

Pembahasan 

Kesimpulan dan Saran 

Selesai 
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3.2 Studi Literatur 

Di dalam tahap studi literatur ini, penulis melakukan  tahap studi literatur melalui : 

1. Jurnal – jurnal 

2. Buku – buku 

3. Penelitian sebelumnya 

Tujuan dari menggunakan referensi-referensi yang disebut di atas pada studi 

literatur penelitian adalah untuk mendapatkan pengertian objek-objek penelitian 

sebagai landasan teori dan pedoman di dalam penelitian ini. 

 

3.3 Gambaran Umum Penelitian 

gambaran umum penelitian ini memiliki tujuan untuk membatasi studi penelitian 

untuk memastikan hasil penelitian yang sesuai dengan pembahasan penelitian, 

serta mengurangi anomali atau kesalahan yang dapat terjadi dalam analisi dan 

pengumpulan data. Gambaran umum penelitian ini membatasi studi penelitian 

yang dibagi menjadi 3 kategori, yaitu subjek penelitian, lokasi penelitian dan data 

penelitian. 

3.3.1 Subjek Penelitian 

Subjek penelitian ini adalah karyawan-karyawan yang bekerja di PT. Taisei 

Pulauintan. 
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3.3.2 Lokasi Penelitian 

Lokasi penelitian yang digunakan berada di Jakarta Selatan, Proyek Two Seno. 

 

Gambar 3. 3 Peta Lokasi 

3.3.3 Data Penelitian 

Data penelitian yang digunakan dalam penelitian ini adalah faktor-faktor yang 

mempengaruhi Efektivitas kerja karyawan. 

 

3.4 Metode Pengumpulan Data 

Metode pengumpulan data adalah teknik yang digunakan peneliti untuk 

memperoleh dan mengumpulkan data yang akan digunakan dalam analisis. Dalam 

penelitian ini, peneliti menggunakan metode kuantitatif dengan metode 

pengumpulan data berupa survei. Penelitian mencangkup dua tahap pengumpulan 

data menggunakan instrumen kuesioner dan wawancara. Data yang terkumpul 

akan digunakan untuk menguji hipotesis dan menjawab pertanyaan yang terdapat 

dalam rumusan masalah, serta diolah untuk menghasilkan temuan penelitian yang 

akan menjadi dasar dalam penarikan kesimpulan dan pemberian saran. 
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3.5 Variabel Penelitian 

Kuesioner dalam penelitian ini dibagi menjadi dua bagian yaitu, data pribadi dan 

data variabel bebas (X). Berikut ini adalah data pribadi responden serta variabel 

bebas yang digunakan dalam penelitian ini: 

a. Data pribadi yang tertera dan harus dijawab oleh responden adalah sebagai 

beriku: 

a. Nama responden 

Nama lengkap daripada responden kuesinoer. 

b. Jenis Kelamin 

Jenis kelamin responden untuk kuesioner penelitian ini yang terdiri 

dari laki-laki dan perempuan. 

c. Usia 

Usia5responden5pada penelitian ini5dibagi5menjadi 4 bagian yaitu 

umur520-295tahun, 30-395tahun, 40-495tahun dan diatas 495tahun. 

d. Status pekerjaan 

Status pekerjaan pada penelitian ini dibagi menjadi 3 bagian yaitu 

Karyawan Tetap, Karyawan Kontrak dan Karyawan Magang. 

b. Variabel Bebas/Independent (X) 

Variabel bebas merupakan variabel yang berpengaruh terhadap Efektivitas 

kerja karyawan. Pada Tabel 3.2 terdapat daftar pernyataan dan indikator-

indikator variabel independen yang nantinya akan disebarkan kepada 

responden penelitian dalam bentuk kuesioner. 
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Tabel 3. 1 Variabel Penelitian 

Variabel Kode Indikator 

Faktor Tenaga Kerja 

Tk1 Umur Tenaga Kerja 

Tk2 
Pengalaman dan 

keahlian 

Tk3 Disiplin Tenaga Kerja 

Tk4 Kondisi Kesehatan 

Faktor Manajemen 

 

M1 

 

Kepemimpinan5dan 

kompetensi5manajer 

M2 

Komunikasi5yang5baik 

antara pekerja,5mandor, 

supervisor,5pengawas 

dan manajer5lapangan 

M3 
Pengawasan5terhadap 

pekerja5 

M4 

Perencanaan dan 

penjadwalan pekerjaan 

yang tepat dan realistis 

Faktor Motivasi 

Mo1 
Besaran5upah5tenaga 

kerja 

Mo2 
Ketetapan waktu 

pembayaran5upah 

Mo3 

Jaminan untuk 

kecelakaan5kerja atau 

jaminan5sosial 

Faktor5Pelaksanaan 

Proyek5 
Pp1 

Jumlah5dan5komposisi 

tenaga5kerja 
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Tabel 3. 2 Variabel Penelitian (Lanjutan I) 

Variabel Kode Indikator 

Faktor Pelaksanaan 

Proyek 

Pp2 

Ketersiadaan dan lokasi 

gudang (penyimpanan) 

material di lapangan 

Pp3 

Ketidakjelasan5instruksi 

dan5perintah yang 

berubah-rubah5selama 

pelaksanaan5pekerjaan 

Faktor Eksternal 

E1 
Kondisi ekonomi5dan 

politik 

 

E2 

 

Peraturan5dan 

perundang-undangan 

E3 
Kondisi5lingkungan, 

sosial5dan5budaya 

Faktor5Material5dan 

Peralatan 

Mp1 
Kondisi5dan5kualitas 

peralatan5 

Mp2 
Kecukupan jumlah 

peralatan5di lapangan 

Mp3 
Kondisi dan kualitas 

material 

Mp4 
Kecukupan jumlah 

material di lapangan 

Faktor Lingkungan 

dan Kondisi5Kerja 

Lk1 
Keterbatasan5area 

tempat5kerja 

Lk2 
Layout5dan5kondisi 

lapangan5 

Lk3 

Kondisi5tempat5kerja 

(Area5berbahaya, 

paparan5racun 
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Tabel 3. 3 Variabel Penelitian (Lanjutan II) 

Variabel Kode Indikator 

Faktor Teknis 

T1 
Tingkat5kesulitan5dan 

kerumitan5desain 

T2 
Perubahan5desain5dan 

spesifikasi5teknis 

T3 
Metode dan teknologi 

konstruksi 

Faktor Waktu 

W1 Frekuensi kerja lembur 

W2 

Kedisiplinan5pekerja 

terhadap5waktu5(datang, 

istirahat5dan5pulang 

sesuai jadwal) 

W3 
Ketersediaan5waktu 

istirahat5yang5cukup 

Faktor Keselamatan 

Kerja 

K1 

Kedisiplinan terhadap 

pelaksanaan dan 

keselamatan kerja 

K2 
Ketersediaan5peralatan 

keselamatan5kerja 

K3 

Ketersediaan5rambu-

rambu5keselamatan 

kerja 

Sumber: (Noviyasi, 2023) 

 

3.6 Bentuk Penelitian 

Bentuk penelitian mencangkup beberapa variabel indikator yang akan 

dihubungkan dengan variabel X (Kinerja Karyawan) terhadap variabel Y 

(Produktivitas Perusahaan). Bentuk penelitian berguna untuk menjelaskan 
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hubungan antara variabel-variabel terhadap kinerja karyawan yang akan 

mempengaruhi produktivitas perusahaan. Bentuk penelitian dapat dilihat dibawah. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tk1 Tk2 Tk3 Tk4 
M1 

M2 

M3 

M4 

Mo1 

Mo2 

Mo3 

Pp1 

Pp2 

Pp3 

E1 

E2 

E3 

Mp

1 
Mp

2 
Mp

3 
Mp

4 
Lk1 

Lk2 

Lk3 

T1 

T2 

T3 
W1 W2 W3 K1 

K3 

K2 

X 

Kinerja 

Karyawan 

Y 

Produktivitas 

Perusahaan 

Gambar 3. 4 Bentuk Penelitian 
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3.7 Teknik Pengumpulan Data 

Dalam proses ini, teknik pengumpulan data yang digunakan dalam penelitian 

berupa instrumen-instrumen yang termasuk dalam metode pengumpulan data 

secara wawancara dan survei. Instrumen-instrumen yang digunakan berupa: 

a. In-depth Wawancara (Wawancara) 

b. Kuesioner (Survei) 

3.7.1 Wawancara 

Wawancara digunakan untuk mendapatkan data penelitian dalam validasi pakar 

yang akan digunakan untuk analisis data menggunakan Delphi Theory. Tujuan 

dari wawancara ini untuk menjawab salah satu perumusan permasalahan di dalam 

penelitian ini.  

Tabel 3. 4 Skala Nilai Wawancara 

Keterangan Bobot Nilai 

Ya 1 

Tidak 0 

 

3.7.2 Kuesioner 

Kuesioner adalah alat penelitian yang berisi berbagai pertanyaan yang disebarkan 

kepada responden atau subjek penelitian untuk mengumpulkan data yang 

diperlukan dalam proses analisis. Kuesioner memiliki sifat yang mirip dengan 

wawancara, namun pengumpulan data dilakukan secara tertulis. 

Tabel 3. 5 Bobot Nilai untuk Skala Likert 

Skala Likert Bobot Nilai 

Sangat5Sedikit5Berpengaruh 1 
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Tabel 3. 6 Bobot Nilai untuk Skala Likert (Lanjutan) 

Skala Likert Bobot Nilai 

Sedikit5Berpengaruh 2 

Netral 3 

Berpengaruh 4 

Sangat5Berpengaruh 5 

 

3.7.3 Metode Pembuatan Kuesioner 

Menurut (Salahudin, 2010), ada beberapa hal yang harus diperhatikan dalam 

pembuatan kuesioner, yaitu: 

1. Gunakan kuesioner dalam kondisi yang paling tepat. Misalnya, memiliki waktu 

yang terbatas namun tetap mempertimbangkan untuk mencangkup banyak 

tujuan yang luas. 

2. Tentukan tujuan kuesioner. Hasil apa yang ingin dipaparkan dan sesuai dengan 

latar belakang penelitian, dapat menjawab rumusan masalah. Karena tujuan 

inilah yang menentukan pertanyaan yang kita rumuskan. 

3. Susun pertanyaan kuesioner sebaik mungkin. Banyak survei yang tidak dapat 

digunakan karena berisi pertanyaan yang salah. 

 

3.8 Teknik Analisis Data 

Berdasarkan data yang telah dikumpulkan dan dirangkum, proses pengolahan data 

dalam penelitian ini dibagi menjadi lima bagian, yaitu: 
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a. Delphi’s Theory 

Pada tahap ini, dilakukan pengujian mengguna teori Delphi. Dalam penelitian ini, 

pengujian Delphi’s Theory dilakukan setelah pengumpulan data melalui validasi 

awal yang dijawab oleh 3 (tiga) pakar. Pengujian ini berguna untuk mengetahui 

variabel-variabel yang mempengaruhi kinerja karyawan. Pemilihan pakar ini 

memiliki persyaratan pengalaman kerja lebih dari 5 (lima) tahun. Delphi’s Theory 

dilakukan sebanyak 2 (dua) putaran. 

Berikut adalah kriteria-kriteria yang akan digunakan dalam pengujian Delphi’s 

Theory. 

Tabel 3. 7 Kriteria Analisis Delphi’s Theory 

Kriteria Nilai 

Ya 1 

Tidak 0 

 

Dari tabel 3. 4 diatas, maka dapat diambil keputusan apakah variabel tersebut 

mempengaruhi kinerja karyawan. Untuk pengambilan keputusan dapat dilihat 

pada tabel 3. 5 dibawah ini.  

b. Uji5Validitas 

Pada tahap ini, dilakukan uji validitas dengan metode Bivariate Pearson 

menggunakan perangkat lunak IBM SPSS untuk menilai apakah variabel-variabel 

dalam kuesioner valid atau tidak. Nilai-nilai hasil uji ini akan dibandingkan 

dengan kriteria yang telah ditetapkan dalam tabel 2.1 diatas. Langkah-langkah 

yang dilakukan oleh peneliti adalah sebagai berikut: 
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1. Memasukkan data ke dalam aplikasi IBM SPSS, data yang dimaksud 

dapat berupa File Excel yang sudah berisi data-data yang telah 

dikumpulkan dari penelitian yang dilakukan. Langkah untuk memasukkan 

data ke dalam aplikasi SPSS adalah File → Import Data → Excel. 

2. Klik pilihan Analyze → Correlate → Bivariate 

3. Masukkan seluruh variabel bebas (X) dan skor total lalu pilih pilihan one-

tailed untuk pengujian satu arah, lalu klik OK. 

c. Uji5Reliabilitas 

Pada tahap ini, dilakukan pengujian reliabilitas untuk mengevaluasi apakah 

kuesioner yang telah didistribusikan dapat diandalkan atau tidak. Hal ini 

dilakukan untuk memastikan bahwa jawaban yang diperoleh dari setiap 

pertanyaan konsisten dari waktu ke waktu. Pengujian reliabilitas menggunakan 

perangkat lunak IBM SPSS untuk menghitung nilai Cronbach's alpha. Nilai 

Cronbach's alpha ini akan dibandingkan dengan kriteria yang tertera dalam tabel 

2.2 diatas. Langkah-langkah yang dilakukan oleh peneliti untuk menguji 

reliabilitas adalah sebagai berikut: 

1. Memasukkan data ke dalam aplikasi IBM SPSS, data yang dimaksud 

dapat berupa File Excel yang sudah berisi data-data yang telah 

dikumpulkan dari penelitian yang dilakukan. Langkah untuk memasukkan 

data ke dalam aplikasi SPSS adalah File → Import Data → Excel. 

2. Klik pilihan Analyze → Scale → Reliability Analyze 

3. Masukkan seluruh variabel bebas (X) lalu klik OK. 

d. Uji5Normalitas 
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Pada tahap ini, dilakukan uji normalitas pada data yang telah terkumpul untuk 

memeriksa apakah distribusi data dari hasil kuesioner bersifat normal atau tidak. 

Uji normalitas menggunakan metode Kolmogorov-Smirnov dengan menggunakan 

perangkat lunak IBM SPSS. Hasil uji normalitas dievaluasi berdasarkan nilai 

signifikansi, di mana jika nilai signifikansi lebih besar dari 0,05, dapat 

disimpulkan bahwa distribusi data bersifat normal. Berikut adalah langkah-

langkah yang dilakukan untuk melakukan uji normalitas dengan metode 

Kolmogorov-Smirnov menggunakan perangkat lunak IBM SPSS: 

1. Memasukkan data ke dalam aplikasi IBM SPSS, data yang dimaksud 

dapat berupa File Excel yang sudah berisi data-data yang telah 

dikumpulkan dari penelitian yang dilakukan. Langkah untuk memasukkan 

data ke dalam aplikasi SPSS adalah File → Import Data → Excel. 

2. Langkah selanjutnya, memunculkan nilai unstandardized residual (RES_1) 

dengan cara memilih Analyze → Regression → Linear. 

3. Selanjutnya, masukkan variabel Y kedalam kolom Independent dan 

seluruh variabel X kedalam kolom Dependent. 

4. Untuk melakukan uji Kolmonorov-Smirnov di dalam IBM SPSS, dapat 

melakukan tahap Analyze → Nonparametric Test → Legacy Dialogs → 1-

Sample KS → lalu masukan data unstandardized residual lalu klik OK. 

e. Uji Indeks Kepentingan Relatif 

Setelah selesai melakukan pengujian validitas dan reliabilitas, dilakukan 

pengujian Indeks Kepentingan Relatif (IKR) untuk menentukan variabel yang 

paling berpengaruh pada setiap indikator dalam kuesioner (Celine Faustine, 2022). 

Kuesioner ini mencakup sepuluh variabel yang akan dievaluasi, seperti Faktor 
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Tenaga Kerja, Manajemen, Motivasi, Pelaksanaan Proyek, Faktor Eksternal, 

Material dan Peralatan, Lingkungan dan Kondisi Kerja, Teknis, Waktu, dan 

Keselamatan Kerja. Variabel-variabel ini kemudian dianalisis untuk mendapatkan 

kesimpulan berdasarkan hasil perhitungan, yang selanjutnya akan dijelaskan 

secara deskriptif. Uji IKR menetapkan tingkat kepentingan relatif dengan 

menggunakan skala yang tercantum dalam tabel 3. 6 dibawah ini. 

 

Tabel 3. 8 Rentang Level Kepentingan Nilai RII 

Rentang5Nilai5RII Level5Kepentingan 

0,85≤ RII5≤ 1 High5(H) 

0,65≤5RII ≤50,8 High-Medium5(H-M) 

0,45≤5RII ≤50,6 Medium5(M) 

0,25≤5RII ≤50,4 Medium-Low5(M-L) 

0 ≤5RII ≤50,2 Low5(L) 

          Sumber: (Celine Faustine, 2022) 

Penulis melakukan pengujian indeks kepentingan relatif dengan bantuan 

perangkat lunak Microsoft Excel. Rumus yang digunakan untuk mencari nilai RII 

dapat dilihat dibawah. 

RII (%) =  
5 (N5)+4 (N4)+(3 (N3)+2 (N2)+ N1

W ×(N5+ N4+ N3+ N2+ N1
 

Ket : 

RII = Nilai Relatif Kepentingan Indeks 

N5 = Jumlah responden5yang5mengisi5skala 5 

N4 = Jumlah responden5yang5mengisi5skala 4 

N3 = Jumlah responden5yang5mengisi5skala 3 

N2 = Jumlah responden5yang5mengisi5skala 2 
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N1 = Jumlah responden5yang5mengisi5skala 1 

W =5Skala terbesar dalam kuesioner 

e. Uji5Korelasi 

Setelah memastikan bahwa data yang telah dikumpulkan valid, reliabel, dan 

memiliki distribusi normal yang baik, dilakukan analisis korelasi antara variabel 

X dan Y menggunakan perangkat lunak IBM SPSS. Uji korelasi ini bertujuan 

untuk menilai hubungan antara kedua variabel tersebut.  

Untuk melihat derajat atau tingkat hubungan faktor-faktor5yang5mempengaruhi 

Efektivitas5kerja5karyawan dapat digunakan tabel interprestasi korelasi dibawah 

berikut. 

Tabel 3.9 Indikator Tingkat Hubungan5Korelasi  

Interval5Koefisien 

Korelasi 
Tingkat5Hubungan 

0,005–50,199 Sangat5Lemah 

0,205–50,399 Lemah 

0,405–50,599 Sedang 

0,605–50,799 Kuat 

0,805–51,000 Sangat5Kuat 

 

Tabel 3. 7 memperlihatkan tingkat hubungan berdasarkan rentang koefisien 

korelasi. Rentang koefisien antara 0,00 hingga 0,199 menunjukkan bahwa 

hubungan antara kedua variabel sangat lemah. Rentang koefisien 0,2 hingga 0,399 

menunjukkan hubungan yang lemah antara kedua variabel. Jika koefisien korelasi 

berada di rentang 0,6 hingga 0,799, maka hubungan antara kedua variabel 

dianggap kuat. 
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Tahap-tahap yang digunakan penulis untuk melakukan pengujian korelasi adalah 

sebagai berikut: 

1. Pilih menu Analyze → Correlate → Bivariate…  

2. Masukkan variabel X dan variabel Y pada kotak Variables, lalu centang 

pilihan “Pearson” di kolom Correlation Coefficients, lalu pilih “Two-tailed” 

di kolom Test of Significance dan centang checkbox “Flag significant 

correlation”. 
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BAB 4 

ANALISIS DAN PEMBAHASAN 

 

4.1 Pendahuluan 

Pada bab ini disajikan hasil analisis dari data-data yang telah dikumpulkan serta 

pembahasan. Data-data yang telah dikumpulkan diperoleh melalui penyebaran 

kuesioner secara online oleh penulis. Penyebaran kuesioner atau pengambilan data 

dilaksanakan pada bulan Mei sampai bulan Juni tahun 2024. Penelitian ini 

bertujuan untuk mengetahui dan menganalisis faktor-faktor yang mempengaruhi 

efektifitas kerja karyawan PT. Taisei-Pulauintan studi kasus proyek Two Seno 

Apartemen di Senopati, Jakarta Selatan. 

 

4.2 Validasi Pakar 

Pada tahap perencanaan penelitian, validasi pakar dilakukan kepada tiga orang 

yang sudah memiliki pengalaman kerja diatas 5 tahun untuk membantu penentuan 

variabel faktor-faktor yang akan digunakan atau tidak.  

4.2.1 Profil Pakar 

Profil pakar ini berisikan tentang latar belakang para pakar/ahli yang terdiri dari 

nama, jabatan pekerjaan, umur dan durasi pengalaman bekerja. Profil pakar dapat 

dilihat pada tabel 4. 1 dibawah ini. 
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Tabel 4. 1 Profil Pakar  

 Nama Umur 
Pengalaman 

Bekerja 

Jabatan 

Pekerjaan 

Pakar 1 
Andre 

Pakpahan 
33 Tahun 8 Tahun Site Manager 

Pakar 2 
Akhmad 

Baihaqi 
63 Tahun 43 Tahun Project Manager 

Pakar 3 Putri Yasmin 30 Tahun 6 Tahun Ast. Manager HSE 

 

Dari tabel 4. 1 diatas, dapat disimpulkan bahwa dari ketiga pakar yang di 

wawancara tersebut, ketiganya memiliki persamaan yaitu memiliki pengalaman 

bekerja diatas 5 tahun. 

 

4.3 Uji Delphi’s Theory 

Pengujian Delphi’s Theory dilakukan untuk menjawab permasalahan pertama 

dalam penelitian yaitu mencari ada tau tidaknya pengaruh sebuah variabel 

terhadap kinerja karyawan. Pengujian Delphi’s Theory di dalam penelitian ini 

dilakukan sebanyak 2 (dua) putaran. Putaran pertama dilakukan tanpa perputaran 

pendapat antara ketiga pakar. Putaran kedua dilakukan setelah ketiga pakar telah 

berputar pendapat masing-masing. Setelah putaran kedua, maka akan dilakukan 

anslisis Delphi’s Theory untuk mengetahui variabel apa yang memengaruhi 

kinerja karyawan di PT. Taisei-Pulauintan Bajaperkasa. 
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Tabel 4. 2 Hasil Validasi Pakar Putaran 1 

Variabel 

Pakar 1 Pakar 2 Pakar 3 

Ya Tidak Ya Tidak Ya Tidak 

Faktor Tenaga Kerja 

(X1) 
✓  ✓  ✓  

Faktor Manajemen (X2) ✓  ✓  ✓  

Faktor Motivasi (X3) ✓  ✓  ✓  

Faktor Pelaksanaan 

Proyek (X4) 
✓  ✓  ✓  

Faktor Eksternal (X5)  ✓  ✓  ✓ 

Faktor Material dan 

Peralatan (X6) 
✓  ✓  ✓  

Faktor Lingkungan dan 

Kondisi Ruang Kerja 

(X7) 

✓  ✓  ✓  

Faktor Teknis (X8) ✓   ✓ ✓  

Faktor Waktu (X9) ✓  ✓  ✓  

Faktor Keselamatan 

Kerja (X10) 
✓  ✓  ✓  

 

Setelah mendapatkan jawaban dari ketiga pakar maka dapat dilakukan pengujian 

Delphi’s Theory untuk mengetahui variabel yang beperngaruh atau tidak dalam 

validasi pakar putaran 1 (satu). Hasil analisis dapat dilihat pada tabel dibawah. 
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Tabel 4. 3 Hasil Analisis Delphi’s Theory Putaran 1 

Variabel Ya Tidak 

Faktor Tenaga Kerja (X1) 3 0 

Faktor Manajemen (X2) 3 0 

Faktor Motivasi (X3) 3 0 

Faktor Pelaksanaan Proyek (X4) 3 0 

Faktor Eksternal (X5) 0 3 

Faktor Material dan Peralatan (X6) 3 0 

Faktor Lingkungan dan Kondisi Ruang Kerja (X7) 3 0 

Faktor Teknis (X8) 2 1 

Faktor Waktu (X9) 3 0 

Faktor Keselamatan Kerja (X10) 3 0 

 

Dari tabel 4. 3 diatas, dapat disimpulkan bahwa Faktor Eksternal (X5) memiliki 

poin 0 di kolom “Ya”. Maka dari itu, variabel Faktor Eksternal (X5) tidak akan 

dilanjutkan ke dalam validasi pakar putaran ke-2 dan tidak dimasukkan kedalam 

analisis kedepannya. 

Setelah itu, dilakukanlah validasi pakar putaran ke-2. Dalam putaran ini, ketiga 

pakar akan melakukan perputaran pendapat mereka masing-masing sebelum 

menjawab formulir validasi pakar. Hasil dari validasi pakar putaran ke-2 dapat 

dilihat pada tabel 4. 4 dibawah ini. 
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Tabel 4.  4 Validasi Pakar Tahap 2 

Variabel 

Pakar 1 Pakar 2 Pakar 3 

Ya Tidak Ya Tidak Ya Tidak 

Faktor Tenaga Kerja 

(X1) 
✓  ✓  ✓  

Faktor Manajemen (X2) ✓  ✓  ✓  

Faktor Motivasi (X3) ✓  ✓  ✓  

Faktor Pelaksanaan 

Proyek (X4) 
✓  ✓  ✓  

Faktor Material dan 

Peralatan (X6) 
✓  ✓  ✓  

Faktor Lingkungan dan 

Kondisi Ruang Kerja 

(X7) 

✓  ✓  ✓  

Faktor Teknis (X8) ✓   ✓  ✓ 

Faktor Waktu (X9) ✓  ✓  ✓  

Faktor Keselamatan 

Kerja (X10) 
✓  ✓  ✓  

 

Setelah mendapatkan jawaban dari ketiga pakar maka dapat dilakukan pengujian 

Delphi’s Theory untuk mengetahui variabel yang beperngaruh atau tidak dalam 

validasi pakar putaran 2 (dua). Hasil analisis dapat dilihat pada tabel 4. 5 dibawah 

ini. 
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Tabel 4. 5 Hasil Penelitian Delphi’s Theory Putaran 2  

Variabel Ya Tidak 

Faktor Tenaga Kerja (X1) 3 0 

Faktor Manajemen (X2) 3 0 

Faktor Motivasi (X3) 3 0 

Faktor Pelaksanaan Proyek (X4) 3 0 

Faktor Material dan Peralatan (X6) 3 0 

Faktor Lingkungan dan Kondisi Ruang Kerja (X7) 3 0 

Faktor Teknis (X8) 1 2 

Faktor Waktu (X9) 3 0 

Faktor Keselamatan Kerja (X10) 3 0 

 

Dari tabel 4. 3 diatas, dapat disimpulkan bahwa Faktor Teknis (X8) memiliki poin 

1 dari 3 di kolom “Ya”. Maka dari itu, variabel Faktor Teknis (X8) tidak akan 

dimasukkan kedalam analisis kedepannya. 

Dari hasil Delphi’s Theory yang dilaksanakan sebanyak 2 putaran, maka dapat 

disimpulkan bahwa variabel Eksternal (X5) dan variabel Teknis (X8) tidak 

mempunyai pengaruh terhadap kinerja karyawan. 

 

4.3 Rangkuman Data 

Pada tahap perencanaan penelitian, jumah responden yang direncanakan 

berjumlah 35 orang. Pada tabel 4.2 dan tabel 4.3 akan ditampilkan jumlah data 
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responden berdasarkan usia dan durasi pengalaman kerja masing-masing 

responden. 

Tabel 4. 6 Jumlah Responden Berdasarkan Usia Karyawan 

Usia Karyawan Jumlah Responden 

20 - 24 Tahun 7 

25 - 29 Tahun 11 

30 - 34 Tahun 13 

≥ 35 Tahun 9 

Jumlah 40 

 

 

Gambar 4. 1 Pie Chart Distribusi Responden Berdasarkan Usia Karyawan 

Berdasarkan tabel 4.2 dan gambar 4.1 maka dapat disimpulkan bahwa dari 40 

responden, responden terbanyak adalah responden yang ber-usia 30 sampai 

dengan 34 tahun sebanyak 13 responden. Sedangkan responden yang ber-usia 20 
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sampai dengan 24 tahun memiliki jumlah responden terendah sebanyak 7 

responden. 

Tabel 4. 7 Jumlah Responden Berdasarkan Durasi Pengalaman Kerja 

Pengalaman Kerja Jumlah Responden 

< 1 Tahun 5 

1 - 2 Tahun 4 

3 - 5 Tahun 9 

> 5 Tahun 22 

Jumlah 40 

 

 

Gambar 4. 2 Pie Chart Jumlah Responden Berdasarkan Durasi Pengalaman 

Kerja 

Berdasarkan tabel 4.3 dan gambar 4.2 maka dapat disimpulkan bahwa dari 40 

responden, jumlah5responden terbanyak adalah5responden5yang5memiliki 

pengalaman5kerja diatas 5 tahun5sebanyak 22 responden. Sedangkan jumlah 
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respoden terendah5adalah5responden yang5memiliki5pengalaman5kerja selama 1 

sampai dengan 2 tahun sebanyak 4 responden. 

 

4.4 Uji Normalitas 

Uji normalitas dilakukan menggunakan metode uji Kolmogorov-Smirnov. 

Pengujian normalitas dilakukan untuk menentukan apakah distribusi data dalam 

penelitian bersifat normal atau tidak. Uji normalitas memiliki dua dasar 

pengambilan keputusan, yaitu: 

1. Jika_nilai_signifikansi_(Sig.) lebih_besar_dari 0,05_maka_data_penelitian 

berdistribusi normal. 

2. Jika_nilai_signifikansi_(Sig.) lebih_kecil_dari 0,05 maka_data_penelitian 

tidak berdistribusi nor mal. 

Berikut adalah hasil uji normalitas dengan responden sebanyak 40 orang 

menggunakan perangkat lunak IBM SPSS dengan metode uji Kolmogorov-

Smirnov. 

Tabel 4. 8 Hasil Uji Normalitas 

 Unstandarized Residual 

N  40 

Normal parameters a.b 
Mean .0000000 

Std. Deviation .22288357 

Most Extreme Differences 

Absolute .075 

Positive .075 

Negative .075 

Test Statistic .075 

Asymp. Sig. (2-tailed) .200 
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Dari hasil uji normalitas, menunjukan angka signifikasi berada diatas angka 0,05 

dan membuktikan bahwa distribusi data dalam penelitian ini bersifat normal. 

 

4.5 Uji Validitas 

Peneliti melakukan pengujian validitas dengan menggunakan metode Bivariate 

Pearson. Jumlah responden yang digunakan dalam pengujian ada sebanyak 40 

responden dengan 10 variabel bebas. Dengan ketentuan seperti berikut: 

1. Jika hasil dari R hitung diatas R tabel maka variabel tersebut dapat 

dikatakan valid. 

2. Sebaliknya, jika hasil dari R hitung dibawah atau sama dengan R tabel 

maka variabel tersebut dikatakan tidak valid. 

Peneliti menggunakan tingkat signifikasi sebesar 0,05 dengan uji satu arah. 

Sehingga, R tabel dengan jumlah responden 40 orang adalah 0,2638. 

Tabel 4. 9 Hasil Uji Validitas 

Variabel 
Pertanyaan Validitas Makna 

Faktor Tenaga 

Kerja 

Apakah umur tenaga kerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,392 Valid 

Apakah pengalaman dan keahlian dari 

pekerja dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,430 Valid 

Apakah kedisiplinan dari pekerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,311 Valid 

Apakah kondisi kesehatan dari pekerja 

dapat mempengaruhi kerja karyawan? 
0,331 Valid 
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Tabel 4. 10 Hasil Uji Validitas (Lanjutan I) 

Variabel 
Pertanyaan Validitas Makna 

Faktor 

Manajemen 

Apakah kepemimpinan dan kompetensi 

manajer dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,654 Valid 

Apakah komunikasi5yang5baik5antara 

pekerja,5mandor,5supervisor,5pengawas 

dan manajer dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,380 Valid 

Apakah pengawasan terhadap pekerja 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,301 Valid 

Apakah perencanaan5dan5penjadwalan 

pekerjaan5yang5tepat5dan realistis 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,311 Valid 

Faktor Motivasi 

Apakah besaran upah tenaga kerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

 

0,372 Valid 

 

Faktor Motivasi 

Apakah ketetapan waktu pembayaran 

upah dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,327 Valid 

Apakah jaminan untuk kecelakaan kerja 

atau jaminan sosial dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,529 Valid 

Apakah pengawasan terhadap pekerja 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,287 Valid 
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Tabel 4. 11 Hasil Uji Validitas (Lanjutan II) 

Variabel 
Pertanyaan Validitas Makna 

Faktor 

Pelaksanaan 

Proyek 

Apakah jumlah5dan5komposisi5tenaga 

kerja dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,401 Valid 

Apakah ketersiadaan dan lokasi gudang 

material di lapangan yang baik dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,470 Valid 

Apakah ketidakjelasan5instruksi5dan 

perintah yang berubah-rubah5selama 

pelaksanaan5pekerjaan dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,490 Valid 

Faktor Material 

dan Peralatan 

Kerja 

Apakah kondisi dan kualitas peralatan 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,413 Valid 

Apakah kecukupan jumlah peralatan 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,344 Valid 

Apakah kondisi dan kualitas material 

dapat mempengaruhi Efektivitas kerja? 
0,461 Valid 

Faktor Material 

dan Peralatan 

Kerja 

Apakah kecukupan material dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,487 Valid 

Faktor Kondisi 

Lingkungan 

Kerja 

Apakah keterbatasan area tempat kerja 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,355 Valid 

Apakah layout dan kondisi lapangan 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,405 Valid 
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Tabel 4. 12 Hasil Uji Validitas (Lanjutan III) 

Variabel 
Pertanyaan Validitas Makna 

Faktor Kondisi 

Lingkungan 

Kerja 

Apakah kondisi tempat kerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,338 Valid 

Faktor Waktu 

Apakah frekuensi hari libur dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,331 Valid 

Apakah kedisiplinan pekerja terhadap 

waktu kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,347 Valid 

Apakah ketersediaan waktu istirahat 

yang cukup dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,372 Valid 

Faktor 

Keselamatan 

Kerja 

Apakah kedisiplinan terhadap 

pelaksanaan dan keselamatan kerja 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,395 Valid 

Faktor 

Keselamatan 

Kerja 

Apakah ketersiadaan peralatan 

keselamatan kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,386 
Valid 

Apakah ketersediaan rambu-rambu 

keselamatan kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,328 
Valid 
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Dari tabel 4. 12 diatas, dapat diketahui bahwa seluruh indikator pertanyaan dari 10 

variabel yang tersedia memiliki nilai R Hitung diatas R tabel, sehingga pertanyaan 

tersebut terbukti valid. 

 

4.6 Uji Reliabilitas 

Peneliti melakukan pengujian reliabilitas dengan metode Conbrach’s Alpha 

dengan jumlah responden sebanyak 40 orang. Hasil dari pengujian reliabilitas 

dapat dilihat pada tabel 4. 13 dengan persyaratan: 

1. Jika nilai reliabilitas diatas 0,60 maka variabel dinyatakan beriabel baik. 

2. Sedangkan jika nilai reliabilitas dibawah atau sama dengan 0,60 maka 

variabel dinyatakan beriabel tidak baik. 

Tabel 4. 13 Hasil Uji Reliabilitas 

Variabel 
Pertanyaan Reliabilitas Makna 

Faktor Tenaga 

Kerja 

Apakah umur tenaga kerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,861 Baik 

Apakah pengalaman dan keahlian 

dari pekerja dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,860 Baik 

Apakah kedisiplinan dari pekerja 

dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,863 Baik 

Apakah kondisi kesehatan dari 

pekerja dapat mempengaruhi kerja 

karyawan? 

0,864 Baik 
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Tabel 4. 14 Hasil Uji Reliabilitas (Lanjutan I) 

Variabel 
Pertanyaan Reliabilitas Makna 

Faktor 

Manajemen 

Apakah kepemimpinan dan 

kompetensi manajer dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,851 Baik 

Apakah komunikasi5yang 

baik5antara pekerja5 

mandor,5supervisor,5pengawas5dan 

manajer dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,862 Baik 

Apakah pengawasan terhadap pekerja 

dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,862 Baik 

Apakah perencanaan5dan 

penjadwalan5pekerjaan5yang5tepat 

dan realistis dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,863 Baik 

Faktor Motivasi 

Apakah besaran upah tenaga kerja 

dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,863 Baik 

Apakah ketetapan waktu pembayaran 

upah dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,862 Baik 

Apakah jaminan untuk kecelakaan 

kerja atau jaminan sosial dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,858 Baik 
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Tabel 4. 15 Hasil Uji Reliabilitas (Lanjutan II) 

Variabel 
Pertanyaan Reliabilitas Makna 

Faktor Motivasi 

Apakah pengawasan terhadap pekerja 

dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,862 Baik 

Faktor 

Pelaksanaan 

Proyek 

Apakah jumlah5dan5komposisi 

tenaga5kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,861 Baik 

Apakah ketersiadaan dan lokasi 

gudang material di lapangan yang 

baik dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,860 Baik 

Apakah ketidakjelasan5instruksi5dan 

perintah5yang5berubah-

rubah5selama5pelaksanaan pekerjaan 

dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,858 Baik 

Faktor Material 

dan Peralatan 

Kerja 

Apakah kondisi dan kualitas 

peralatan dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,858 Baik 

Apakah kecukupan jumlah peralatan 

dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,861 Baik 

Apakah kondisi dan kualitas material 

dapat mempengaruhi Efektivitas 

kerja? 

0,856 Baik 

Apakah kecukupan material dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,856 Baik 
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Tabel 4. 16 Hasil Uji Reliabilitas (Lanjutan III) 

Variabel 
Pertanyaan Reliabilitas Makna 

Faktor Kondisi 

Lingkungan 

Kerja 

Apakah keterbatasan area tempat 

kerja dapat mempengaruhi Efektivitas 

kerja karyawan? 

0,858 Baik 

Apakah layout dan kondisi lapangan 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,856 Baik 

Apakah kondisi tempat kerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,859 
Baik 

Faktor Waktu 

Apakah frekuensi hari libur dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,861 
Baik 

Apakah kedisiplinan pekerja terhadap 

waktu kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,859 
Baik 

Apakah ketersediaan waktu istirahat 

yang cukup dapat mempengaruhi 

Efektivitas kerja karyawan? 

0,859 
Baik 

Faktor 

Keselamatan 

Kerja 

Apakah kedisiplinan terhadap 

pelaksanaan dan keselamatan kerja 

dapat mempengaruhi Efektivitas kerja 

karyawan? 

0,856 Baik 

Apakah ketersiadaan peralatan 

keselamatan kerja dapat 

mempengaruhi Efektivitas kerja 

karyawan? 

0,855 Baik 

Apakah ketersediaan rambu-rambu 

keselamatan kerja dapat 

mempengaruhi Efektivitas karyawan 

0,857 Baik 
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Tabel 4. 17 Hasil Uji Reliabilitas 

Cronbach’s Alpha Jumlah Indikator 

0,864 28 

Sumber : SPSS 

Dari tabel 4. 13 dan gambar 4. 17 maka dapat disimpulkan bahwa hasil pengujian 

untuk seluruh indikator pertanyaan dari 40 responden memiliki nilai diatas 0,60. 

Sehingga, data penelitian tersebut dapat dikatakan memiliki reliabel baik. 

 

4.7 Uji Korelasi 

Pengujian korelasi dilakukan untuk mengetahui tingkat hubungan antara variabel 

bebas (X) terhadap variabel tidak bebas (Y) dimana variabel bebas dalam 

penelitian ini adalah faktor-faktor terhadap variabel tidak bebas yaitu efektifitas 

kerja karyawan. Pengujian korelasi menghasilkan Nilai interval koefisien 

digunakan untuk menentukan tingkat hubungan antara kedua variabel. Tingkat 

hubungan variabel X terhadap variabel Y ditentukan dari nilai interval koefisien 

dengan peryaratan tabel 4. 18 dibawah ini. 

Tabel 4. 18 Tingkat hubungan variabel 

Interval Koefisien 

Korelasi 
Tingkat Hubungan 

0,00 – 0,199 Sangat Lemah 

0,20 – 0,399 Lemah 

0,40 – 0,599 Sedang 

0,60 – 0,799 Kuat 

0,80 – 1,000 Sangat Kuat 
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Tabel 4. 19 Hasil Uji Korelasi 

Kode Indikator 

Nilai Interval 

Koefisien Korelasi 

Tingkat Hubungan 

Tk1 0,333 Lemah 

Tk2 0,534 Sedang 

Tk3 0,422 Sedang 

Tk4 0,278 Lemah 

M1 0,625 Kuat 

M2 0,497 Sedang 

M3 0,608 Kuat 

M4 0,501 Sedang 

Mo1 0,296 Lemah 

Mo2 0,306 Lemah 

Mo3 0,394 Lemah 

Mo4 0,491 Sedang 

Pp1 0,726 Kuat 

Pp2 0,326 Lemah 
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Tabel 4. 20 Hasil Uji Korelasi (Lanjutan) 

Kode Indikator 
Nilai Interval 

Koefisien Korelasi 
Tingkat Hubungan 

Pp3 0,414 Sedang 

Mp1 0,279 Lemah 

Mp2 0,461 Sedang 

Mp3 0,615 Kuat 

Mp4 0,166 Sangat Lemah 

Lk1 0,279 Lemah 

Lk2 0,353 Lemah 

Lk3 0,184 Sangat Lemah 

W1 0,294 Lemah 

W2 0,507 Kuat 

W3 0,403 Sedang 

K1 0,371 Sedang 

K2 0,475 Sedang 

K3 0,545 Kuat 
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Hasil dari tabel 4.19 diatas dapat diurutkan dari hubungan yang paling kuat 

sampai paling lemah seperti di tabel 4. 21 bawah berikut: 

Tabel 4. 21 Hasil Uji Korelasi yang Telah Ter-urut 

Kode Makna Nilai Interval 
Tingkat 

Hubungan 

Pp1 

Jumlah dan 

komposisi tenaga 

kerja 

0,726 Kuat 

M1 

Kepemimpinan 

dan kompetensi 

manajer 

0,625 Kuat 

Mp3 
Kondisi dan 

kualitas material 
0,615 Kuat 

M3 
Pengawasan 

terhadap pekerja 
0,608 Kuat 

K3 

Ketersediaan 

rambu-rambu 

keselamatan kerja 

0,545 Sedang 

Tk2 
Pengalaman dan 

keahlian 
0,534 Sedang 

W2 

Kedisiplinan 

pekerja5terhadap 

waktu5(datang, 

istirahat5dan 

pulang5sesuai 

jadwal) 

0,507 Sedang 
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Tabel 4. 22 Hasil Uji Korelasi yang Telah Ter-urut (Lanjutan I) 

Kode Makna Nilai Interval 
Tingkat 

Hubungan 

M4 

Perencanaan5dan 

penjadwalan 

pekerjaan5yang 

tepat5dan5realistis 

0,501 Sedang 

M2 

Komunikasi5yang 

baik5antara 

pekerja,5mandor, 

supervisor, 

pengawas5dan 

manajer5lapangan 

0,497 Sedang 

Mo4 
Pengawasan 

terhadap pekerja 
0,491 Sedang 

K2 

Ketersediaan 

peralatan 

keselamatan kerja 

0,475 Sedang 

Mp2 

Kecukupan jumlah 

peralatan di 

lapangan 

0,461 Sedang 

Tk3 
Disiplin Tenaga 

Kerja 
0,422 Sedang 

Pp3 

Ketidakjelasan 

instruksi5dan 

perintah5yang 

berubah-rubah  

0,414 Sedang 
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Tabel 4. 23 Hasil Uji Korelasi yang Telah Ter-urut (Lanjutan II) 

Kode Makna Nilai Interval 
Tingkat 

Hubungan 

W3 

Ketersediaan 

waktu istirahat 

yang cukup 

0,403 Sedang 

Mo3 

Jaminan untuk 

kecelakaan kerja 

atau jaminan 

sosial 

0,394 Lemah 

K1 

Kedisiplinan 

terhadap 

pelaksanaan dan 

keselamatan kerja 

0,371 Lemah 

Lk2 
Layout dan 

kondisi lapangan 
0,353 Lemah 

Tk1 
Umur Tenaga 

Kerja 
0,333 Lemah 

Pp2 

Ketersiadaan dan 

lokasi gudang 

(penyimpanan) 

material di 

lapangan 

0,326 Lemah 

Mo2 
Ketetapan waktu 

pembayaran upah 
0,306 Lemah 

Mo1 Besaran upah  0,296 Lemah 
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Tabel 4. 24 Hasil Uji Korelasi yang Telah Ter-urut (Lanjutan III) 

Kode Makna Nilai Interval 
Tingkat 

Hubungan 

W1 
Frekuensi kerja 

lembur 
0,294 Lemah 

Mp1 
Kondisi dan 

kualitas peralatan 
0,279 Lemah 

Lk1 
Keterbatasan area 

tempat kerja 
0,279 Lemah 

Tk4 Kondisi Kesehatan 0,278 Lemah 

Lk3 

Kondisi5tempat 

kerja5(Area 

berbahaya, 

paparan5racun, 

pencahayaan, 

ventilasi,5suhu, 

tanah) 

0,184 Sangat Lemah 

Mp4 

Kecukupan jumlah 

material di 

lapangan 

0,166 Sangat Lemah 

 

Dari tabel 4. 21 diatas, hasil pengujian korelasi dapat disimpulkan seperti berikut: 

1. Seluruh tabel memiliki nilai positif sehingga menjelaskan bahwa naikknya 

angka indikator variabel terhadap kinerja karyawan maka produktivitas 

perusahaan akan naik. 

(jelaskan 1 1 hubungannya tiap indikator) 
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2. Terdapat indikator yang mempunyayi tingkat hubungan yang bersifat kuat 

yaitu Komposisi tenaga kerja. 

 

4.8 Uji Indeks Kepentingan Relatif 

Pengujian Indeks Kepentingan Relatif digunakan untuk menentukan faktor apa 

yang paling mempengaruhi efektifitas kerja karyawan menurut responden dari 

karyawan di PT. Taisei-Pulauintan study case proyek Two Seno Apartemen. 

Tabel 4.9 dibawah menunjukan hasil tabulasi data kuesioner dari 40 responden 

yang telah dijabarkan per skalanya untuk mempermudah perhitungan Indeks 

Kepentingan Relatif. 

Tabel 4. 25 Hasil Tabulasi Kuesioner 

Kode 

Indikator 

Variabel 

Skala 

1 2 3 4 5 

Tk1 0 0 3 22 15 

Tk2 0 0 5 18 17 

Tk3 0 0 5 17 18 

Tk4 0 0 3 20 17 

M1 0 0 3 21 16 

M2 0 0 2 23 15 

M3 0 0 2 23 15 

M4 0 0 2 22 16 

Mo1 0 0 1 24 15 

Mo2 0 0 1 25 14 

Mo3 0 0 0 28 12 

Mo4 0 0 1 24 15 
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Tabel 4. 26 Hasil Tabulasi Kuesioner (Lanjutan) 

Kode 

Indikator 

Variabel 

Skala 

1 2 3 4 5 

Pp1 0 7 9 13 11 

Pp2 0 0 4 21 15 

Pp3 0 0 2 22 16 

Mp1 0 0 1 25 14 

Mp2 0 0 0 28 12 

Mp3 0 0 0 28 12 

Mp4 0 0 0 27 13 

Lk1 0 0 1 24 15 

Lk2 0 0 1 24 15 

Lk3 0 0 2 23 16 

W1 0 0 0 22 18 

W2 0 0 2 24 14 

W3 0 0 1 21 18 

K1 0 0 0 24 16 

K2 0 0 0 23 17 

K3 0 0 0 25 15 

 

Tabel 4. 27 Hasil Uji Indeks Kepentingan Relatif 

Kode Makna 

Indeks 

Kepentingan 

Relatif 

Tk1 Umur Tenaga Kerja 0,86 

Tk2 Pengalaman dan keahlian 0,86 

Tk3 Disiplin Tenaga Kerja 0,865 

Tk4 Kondisi Kesehatan 0,87 

M1 Kepemimpinan5dan5kompetensi5manajer 0,865 
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Tabel 4. 28 Hasil Uji Kepentingan Relatif (Lanjutan I) 

Kode Makna 

Indeks 

Kepentingan 

Relatif 

M2 
Komunikasi5yang5baik5antara pekerja,5mandor, 

supervisor,5pengawas dan5manajer5lapangan 
0,865 

M3 Pengawasan5terhadap5pekerja 0,865 

M4 
Perencanaan5dan5penjadwalan5pekerjaan5yang 

tepat5dan5realistis 
0,87 

Mo1 Besaran5upah5tenaga5kerja 0,87 

Mo2 Ketetapan waktu5pembayaran5upah 0,865 

Mo3 
Jaminan untuk kecelakaan kerja atau jaminan 

sosial 
0,86 

Mo4 Pengawasan Pekerja 0,87 

Pp1 Jumlah5dan5komposisi tenaga5kerja 0,74 

Pp2 
Ketersiadaan dan5lokasi5gudang5(penyimpanan) 

material5di lapangan 
0,855 

Pp3 
Ketidakjelasan5instruksi5dan5perintah yang 

berubah-rubah5selama5pelaksanaan5pekerjaan 
0,87 

Mp1 Kondisi dan kualitas peralatan 0,865 

Mp2 Kecukupan jumlah peralatan di lapangan 0,86 

Mp3 Kondisi dan kualitas material 0,86 

Mp4 Kecukupan jumlah material di lapangan 0,865 

Lk1 Keterbatasan5area5tempat5kerja 0,87 

Lk2 Layout5dan5kondisi5lapangan 0,87 

Lk3 
Kondisi5tempat5kerja (Area5berbahaya, paparan 

racun,5pencahayaan,5ventilasi,5suhu,5tanah) 
0,87 

W1 Frekuensi kerja lembur 0,89 

W2 
Kedisiplinan5pekerja5terhadap5waktu (datang, 

istirahat5dan5pulang5sesuai jadwal) 
0,86 
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Tabel 4. 29 Hasil Uji Kepentingan Relatif (Lanjutan II) 

Kode Makna 

Indeks 

Kepentingan 

Relatif 

W3 Ketersediaan5waktu5istirahat5yang5cukup 0,885 

K1 
Kedisiplinan terhadap pelaksanaan dan 

keselamatan kerja 
0,88 

K2 Ketersediaan5peralatan5keselamatan5kerja 0,88 

K3 Ketersediaan5rambu-rambu5keselamatan5kerja 0,875 

 

Setelah didapatkan hasil uji indeks kepentingan relatif seperti tabel 4.10 diatas, 

maka dapat dilakukan pengurutan ranking indikator variabel untuk menetukan 

faktor mana yang paling mempengaruhi dan tidak. 

Tabel 4. 30 Ranking Hasil Indeks Kepentingan Relatif 

Kode Makna 

Indeks 

Kepentingan 

Relatif 

Ranking 

W1 Frekuensi kerja lembur 0,89 1 

W3 
Ketersediaan waktu istirahat yang 

cukup 
0,885 2 

K1 
Kedisiplinan terhadap pelaksanaan dan 

keselamatan kerja 
0,88 3 

K2 
Ketersediaan peralatan keselamatan 

kerja 
0,88 3 

K3 
Ketersediaan rambu-rambu 

keselamatan kerja 
0,875 4 

Tk4 Kondisi Kesehatan 0,87 5 

M4 Perencanaan dan penjadwalan  0,87 5 
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Tabel 4. 31 Ranking Hasil Indeks Kepentingan Relatif (Lanjutan I) 

Kode Makna 

Indeks 

Kepentingan 

Relatif 

Ranking 

Mo1 Besaran upah tenaga kerja 0,87 5 

Mo4 Pengawasan Pekerja 0,87 5 

Pp3 

Ketidakjelasan instruksi dan perintah 

yang berubah-rubah selama 

pelaksanaan pekerjaan 

0,87 5 

Lk1 Keterbatasan area tempat kerja 0,87 5 

Lk2 Layout dan kondisi lapangan 0,87 5 

Lk3 

Kondisi tempat kerja (Area berbahaya, 

paparan racun, pencahayaan, ventilasi, 

suhu, tanah) 

0,87 5 

Tk3 Disiplin Tenaga Kerja 0,865 6 

M1 
Kepemimpinan dan kompetensi 

manajer 
0,865 6 

M2 

Komunikasi yang baik antara pekerja, 

mandor, supervisor, pengawas dan 

manajer lapangan 

0,865 6 

M3 Pengawasan terhadap pekerja 0,865 6 

Mo2 
Ketetapan waktu pembayaran upah 

 
0,865 6 

Mp1 Kondisi dan kualitas peralatan 0,865 6 

Mp4 Kecukupan jumlah material di lapangan 0,865 6 

Tk1 Umur Tenaga Kerja 0,86 7 

Tk2 Pengalaman dan keahlian 0,86 7 

Mo3 
Jaminan untuk kecelakaan kerja atau 

jaminan sosial 
0,86 7 

Mp2 
Kecukupan jumlah peralatan di 

lapangan 
0,86 7 
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Tabel 4. 32 Ranking Hasil Indeks Kepentingan Relatif (Lanjutan II) 

Kode Makna 

Indeks 

Kepentingan 

Relatif 

Ranking 

Mp3 Kondisi dan kualitas material 0,86 7 

W2 

Kedisiplinan pekerja terhadap waktu 

(datang, istirahat dan pulang sesuai 

jadwal) 

0,86 7 

Pp2 
Ketersiadaan dan lokasi gudang 

(penyimpanan) material di lapangan 
0,855 8 

Pp1 Jumlah dan komposisi tenaga kerja 0,74 9 

 

Dari hasil tabel 4. 30 diatas, hasil dari pengujian Indeks Kepentingan Relatif dapat 

disimpulkan sebagai berikut: 

1. Faktor yang paling mempengaruhi efektifitas kerja karyawan PT. Taisei-

Pulauintan adalah faktor waktu dengan indikator frekuensi jumlah libur 

dengan angka indeks kepentingan relatif sebesar 0,89. 

2. Faktor terendah yang paling mempengaruhi efektifitas kerja karyawan PT. 

Taisei-Pulauintan adalah faktor pelaksanaan proyek dengan indikator 

jumlah dan komposisi tenaga kerja dengan angka indeks kepentingan 

relatif sebesar 0,74. 

3. Seluruh faktor dan indikator yang disebutkan diatas mempunyayi indeks 

kepentingan relatif dengan level kepentingan High (H), terkecuali faktor 

pelaksanaan proyek indikator jumlah dan komposisi kerja yang berada di 

level kepentingan High-Medium. 
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BAB 5 

KESIMPULAN DAN SARAN 

5.1 Kesimpulan 

Berdasarkan analisis faktor-faktor yang mempengaruhi efektifitas kerja karyawan 

di dalam PT. Taisei-Pulauintan proyek Two Seno Apartemen, jawaban responden 

terhadap kuesioner yang telah dibagikan, maka peneliti dapat menyimpulkan 

bahwa: 

1. Berdasarkan pengujian Delphi’s Theory maka dapat disimpulkan bahwa 

faktor-faktor yang dapat mempengaruhi efektivitas kinerja karyawan 

terhadap produktivitas perusahaan adalah faktor tenaga kerja, faktor 

manajemen, faktor motivasi, faktor pelaksanaan proyek, faktor material 

dan peralatan, faktor kondisi dan lingkungan kerja, faktor waktu dan faktor 

keselamatan kerja. 

2. Berdasarkan hasil uji korelasi, dapat disimpulkan bahwa seluruh indikator 

mempunyayi nilai positif yang berarti dengan meningkatnya sebuah 

indikator tersebut, maka pengaruh terhadap produktivitas perusahaan akan 

meningkat. Terdapat 4 (empat) indikator yang memiliki tingkat hubungan 

kuat terhadap produktivitas perusahan yaitu jumlah dan komposisi tenaga 

kerja, kompetensi manajer, kondisi dan kualitas material dan pengawasan 

terhadap pekerja. Sebaliknya, terdapat 2 (dua) indikator yang memiliki 

tingkat hubungan sangat lemah terhadap produktivitas perusahaan yaitu 

kondisi tempat kerja dan kecukupan jumlah material. 
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5.2 Saran 

Berdasarkan hasil penelitian yang sudah dilakukan, peneliti dapat memberikan 

rekomendasi saran yaitu: 

1. Penambahan tenaga kerja dapat meningkatkan produktivitas perusahaan, 

hal ini berdasarkan dari hasil hubungan yang kuat dan positif dari 

komposisi tenaga kerja dengan kinerja karyawan yang akan meningkatkan 

produktivitas perusahaan. 

2. Penambahan hari libur dapat ditambahkan agar ketersiadaan waktu 

istirahat daripada karyawan di PT. Taisei-Pulauintan dapat ditambahkan. 

Hal ini dapat meningkatkan kinerja karyawan terhadap produktivitas 

perusahaan dan dibuktikan dari hubungan korelasi yang positif. 

3. Untuk penelitian selanjutnya, dapat melakukan penelitian dengan 

perbandingan jika tenaga kerja ditambahkan. 
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LAMPIRAN 1 

Formulir Kuesioner Penelitian 
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LAMPIRAN 1 

Kuesioner Penelitian 

A. Data Responden 

 Nama  : 

 Jenis Kelamin : 

 Usia  : 

 Kisaran Gaji : 

 Pengalaman Kerja : 

B. Keterangan 

Pada masing-masing pertanyaan terdapat lima pilihan jawaban yang mengacu 

pada teknik skala likert 1 s/d 5, skala berikut digunakan untuk Variabel X1 

sampai dengan Variabel X10. 

1 = Sangat Sedikit Berpengaruh 

2 = Sedikit Berpengaruh 

3 = Netral 

4 = Berpengaruh 

5 = Sangat Berpengaruh 

C. Petunjuk Pengisian 

1. Bacalah pertanyaan setiap nomor dengan teliti sebelum menjawab. 

2. Pilihlah jawaban yang menurut anda paling tepat berdasarkan pengalaman 

anda dengan memberikan tanda centang (✓) pada kolom yang telah 

disediakan. 
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D. Daftar Pertanyaan Variabel X1 (Tenaga Kerja) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah umur tenaga kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 
     

2 
Apakah pengalaman dan keahlian dari pekerja 

dapat mempengaruhi Efektivitas kerja karyawan? 
     

3 
Apakah kedisiplinan dari pekerja dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

4 
Apakah kondisi kesehatan dari pekerja dapat 

mempengaruhi kerja karyawan? 
     

 

E. Daftar Pertanyaan Variabel X2 (Manajemen) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah kepemimpinan dan kompetensi manajer 

dapat mempengaruhi Efektivitas kerja karyawan? 
     

2 

Apakah komunikasi yang baik antara pekerja, 

mandor, supervisor, pengawas dan manajer dapat 

mempengaruhi Efektivitas kerja karyawan? 

     

3 
Apakah pengawasan terhadap pekerja dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

4 

Apakah perencanaan dan penjadwalan pekerjaan 

yang tepat dan realistis dapat mempengaruhi 

Efektivitas kerja karyawan? 
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F. Daftar Pertanyaan Variabel X3 (Motivasi) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah besaran upah tenaga kerja dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

2 
Apakah ketetapan waktu pembayaran upah dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

3 

Apakah jaminan untuk kecelakaan kerja atau 

jaminan sosial dapat mempengaruhi Efektivitas 

kerja karyawan? 

     

4 
Apakah pengawasan terhadap pekerja dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

 

G. Daftar Pertanyaan Variabel X4 (Pelaksanaan Proyek) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah jumlah dan komposisi tenaga kerja dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

2 

Apakah ketersiadaan dan lokasi gudang 

penyimpanan material di lapangan yang baik dapat 

mempengaruhi Efektivitas kerja karyawan? 

     

3 

Apakah ketidakjelasan instruksi dan perintah yang 

berubah-rubah selama pelaksanaan pekerjaan dapat 

mempengaruhi Efektivitas kerja karyawan? 
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H. Daftar Pertanyaan Variabel X5 (Eksternal) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah kondisi ekonomi dan politik dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

2 
Apakah peraturan dan perundang-undangan dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

3 
Apakah kondisi lingkungan, sosial dan budaya 

dapat mempengaruhi Efektivitas kerja karyawan? 
     

 

I. Daftar Pertanyaan Variabel X6 (Material dan Peralatan Kerja) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah kondisi dan kualitas peralatan dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

2 
Apakah kecukupan jumlah peralatan dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

3 
Apakah kondisi dan kualitas material dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

4 
Apakah kecukupan material dapat mempengaruhi 

Efektivitas kerja karyawan? 
     

 

 

J. Daftar Pertanyaan Variabel X7 (Kondisi Lingkungan Kerja) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah keterbatasan area tempat kerja dapat 

mempengaruhi Efektivitas kerja karyawan? 
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No Pertanyaan Kuesioner 1 2 3 4 5 

2 
Apakah layout dan kondisi lapangan dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

3 
Apakah kondisi tempat kerja dapat mempengaruhi 

Efektivitas kerja karyawan? 
     

 

K. Daftar Pertanyaan Variabel X8 (Teknis) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah tingkat kesulitan kerumitan desain dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

2 
Apakah perubahan desain dan speksifikasi teknis 

dapat mempengaruhi Efektivitas kerja karyawan? 
     

3 
Apakah metode dan tekonologi konstruksi dapat 

mempengaruhi Efektivitas kerja karyawan? 
     

 

L. Daftar Pertanyaan Variabel X9 (Waktu) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah frekuensi hari libur dapat mempengaruhi 

Efektivitas kerja karyawan? 
     

2 
Apakah kedisiplinan pekerja terhadap waktu kerja 

dapat mempengaruhi Efektivitas kerja karyawan? 
     

3 
Apakah ketersediaan waktu istirahat yang cukup 

dapat mempengaruhi Efektivitas kerja karyawan? 
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M. Daftar Pertanyaan Variabel X10 (Keselamatan Kerja) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 

Apakah kedisiplinan terhadap pelaksanaan dan 

keselamatan kerja dapat mempengaruhi Efektivitas 

kerja karyawan? 

     

2 
Apakah ketersiadaan peralatan keselamatan kerja 

dapat mempengaruhi Efektivitas kerja karyawan? 
     

3 

Apakah ketersediaan rambu-rambu keselamatan 

kerja dapat mempengaruhi Efektivitas kerja 

karyawan? 

     

 

N. Daftar Pertanyaan Variabel Y (Efektivitas Karyawan) 

No Pertanyaan Kuesioner 1 2 3 4 5 

1 
Apakah anda setuju jika efisiensi kerja karyawan 

adalah kunci elemen dari perusahaan yang sukses? 
     

2 

Apakah menurut anda kondisi efisiensi kerja dari 

seorang karyawan sangat penting untuk 

pelaksanaan suatu pekerjaan di suatu proyek? 

     

3 

Apakah anda setuju jika efisiensi kerja karyawan 

harus ditingkatkan atau dipertahankan efisiensinya 

guna untuk sebuah perusahaan? 
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LAMPIRAN 2 

Formulir Validasi Pakar



 

Hal 1/4 

 

LAMPIRAN 2 

Validasi Pakar 

Lampiran Validasi Pakar ini berguna untuk menentukan apakah Ya atau Tidak 

Faktor-faktor tersebut mempengaruhi Efektivitas Karyawan. 

A. Validasi Pakar 1 

Nama Validasi Pakar : Andre Pakpahan 

Posisi : Site Manager 

Faktor Ya Tidak 

Faktor Tenaga Kerja (X1) ✓  

Faktor Manajemen (X2) ✓  

Faktor Motivasi (X3) ✓  

Faktor Pelaksanaan Proyek 

(X4) 
✓  

Faktor Eksternal (X5)  ✓ 

Faktor Material dan 

Peralatan (X6) 
✓  

Faktor Lingkungan dan 

Kondisi Ruang Kerja (X7) 
✓  

Faktor Teknis (X8) ✓  

Faktor Waktu (X9) ✓  

Faktor Keselamatan Kerja 

(X10) 
✓  
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B. Validasi Pakar 2 

Nama Validasi Pakar : Akhmad Baihaqi 

Posisi : Deputy Project Manager 

Faktor Ya Tidak 

Faktor Tenaga Kerja (X1) ✓  

Faktor Manajemen (X2) ✓  

Faktor Motivasi (X3) ✓  

Faktor Pelaksanaan Proyek 

(X4) 
✓  

Faktor Eksternal (X5)  ✓ 

Faktor Material dan 

Peralatan (X6) 
✓  

Faktor Lingkungan dan 

Kondisi Ruang Kerja (X7) 
✓  

Faktor Teknis (X8)  ✓ 

Faktor Waktu (X9) ✓  

Faktor Keselamatan Kerja 

(X10) 
✓  
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C. Validasi Pakar 3 

Nama Validasi Pakar : Putri Yasmin 

Posisi : Ast. Manager HSE 

Faktor Ya Tidak 

Faktor Tenaga Kerja (X1) ✓  

Faktor Manajemen (X2) ✓  

Faktor Motivasi (X3) ✓  

Faktor Pelaksanaan Proyek 

(X4) 
✓  

Faktor Eksternal (X5)  ✓ 

Faktor Material dan 

Peralatan (X6) 
✓  

Faktor Lingkungan dan 

Kondisi Ruang Kerja (X7) 
✓  

Faktor Teknis (X8)  ✓ 

Faktor Waktu (X9) ✓  

Faktor Keselamatan Kerja 

(X10) 
✓  
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D. Tanda Tangan Pakar 

Tanda tangan pakar digunakan sebagai pembuktian bahwa pelaksanaan Validasi 

Pakar ini tidak dimanipulasi. 

 

  

  

Andre Pakpahan  Akhmad Baihaqi  Putri Yasmin 
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FORMULIR BIMBINGAN 
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